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Comparison of the HighDesign editions.

HighDesign is a design and documentation tool for architects and design professionals working in
the Architecture, Engineering and Construction (AEC) industry. With a modern, intuitive interface
and powerful drafting and design functions HighDesign combines computer-aided-design (CAD)
features with advanced building-oriented tools.
The wide range of drafting, design and documentation functions and the sophisticated features of
project organization allow the rapid production of concepts, drafts and designs.
A project in HighDesign is a complete presentation of drawings, views, details, information, images
and layouts that will assist the user in the design workflow from the conceptual to the design and
production phases.

When you download HighDesign from the Ilexsoft website, the software launches as a time-limited
trial version.
The limitations in the Trial version are:
Operative for 30 days of use;
Printed pages and exported images have a “HighDesign Trial” watermark;
HighDesign Trial lets you explore all the available features, including those of the Pro version such
as walls, sheets, views, photogrammetry, etc.. At the end of the trial period, the application will no
longer launch.
When you purchase a license, launch HighDesign and insert your Owner name and License Key
into the License dialog. There is no need to download a separate package.

The download version is a compressed Disk Image file (.dmg). Depending on your Internet
preferences, the file could have already been expanded after the download.
Once the file has been expanded, you should see on your Desktop (or your default download
location) the “HighDesign” dmg file. Double-click it to mount the drive.
To install HighDesign, drag the icon to a folder on your local or network disk. There is no required
location; however, if you have multiple users on your computer, put it in the main Applications folder
to make it accessible to all of them. Note that you will be required to log in as an administrator to
write to the Applications folder.

1. Launch HighDesign, click the Activate button on the first screen or go to
2. Enter name and license key exactly as they appear in the HighDesign Activation email sent
from Ilexsoft.
Upgrade keys must be registered for the same name used in the previous license.
, go to
and click on the License button:
select the license in the table, click the Delete button and confirm.

Quit HighDesign.
Open a Finder window.

Delete the HighDesign folder from the main library:
On the left pane of the Finder window, click Macintosh HD.
In the right pane, click Library, and then Application Support.
In the Application Support folder, find the Ilexsoft HighDesign folder, and then drag it to the
trash
Delete the HighDesign folder from your user library:
On the left pane of the Finder window, click your user name.
Hold down the Option (Alt) button on your keyboard, click Go in the menubar, then
select the Library option in the drop-down list.
Open the Application Support folder.
In the Application Support folder, find the Ilexsoft HighDesign folder, and then drag it to the
trash.
Delete the HighDesign application:
On the left pane of the Finder window, click Applications.
In the right pane, find HighDesign folder, and then drag it to the trash.
Delete the plist file:
On the left pane of the Finder window, click your user name.
Hold down the Option (Alt) button on your keyboard, click Go in the menubar, then
select the Library option in the drop-down list.
In the Preferences folder, drag the following file to the trash: com.ilexsoft.HighDesign.plist

After downloading the file, follow these steps to install HighDesign:
1. Log in to the computer with a user account that has administrator rights;
2. Double-click the EXE install file. You can also context-click and select Run As an
Administrator;
3. Click Next in the Welcome dialog box;
4. Click on the “I accept the terms of this license agreement” button in the End User License
Agreement if you agree to the terms;
5. Click the Next button to install HighDesign in the default location;
6. Click the Install button if you’re satisfied with the settings;
7. Click the Finish button when prompted;
8. Launch HighDesign.

Launch HighDesign, go to
and enter name and license key exactly as
they appear in the HighDesign Activation email sent from Ilexsoft.
Upgrade keys must be registered for the same name used in the previous license.
, go to
and click on the License button: select
the license in the table, click the Delete button and confirm.

To uninstall HighDesign, go to the Start menu (the windows logo) and follow the path below:
Select

>

>

&

>

; Click the “Uninstall” button.

A project in HighDesign is a set of drawings, symbols, views, details and documentation elements
such as annotations, tags, dimensions and non graphic information. It is very important that all
these items are organized in categories with a defined hierarchy.
The objects of the project are logically grouped through Layers and organized as separate
drawings contained in Project Sheets. Project Sheets have their own drawing scale and units.

Each item of the project has its hierarchy which allows to easily structure and organize the different
parts of the drawings. Therefore we have generic and specific objects of the project.
The hierarchy of the items of the project classifies them as:
– any item of the project. It can be a line, a text, a wall, an image a title block, etc.
– 2D drafting objects and shapes such as lines, polygons, circles,
curves.
– graphic objects with advanced settings (hatches, symbols, texts,
annotations, dimensions).
– parametric components of the building such as walls,
columns, doors, windows.
Objects, Graphic Objects, Elements and Building Elements are organized in
, usually
corresponding to the tool options used to draw them: Line, Arc, Wall, Door are different classes of
objects.
Classes of objects can have sub-categories called
are different families of the door class.

: e.g. swinging door and sliding door

The objects of the project can have abstract definitions of their parameters: Basic Styles, Graphic
Styles (for the elements of the project) and Building Element Types (for the building elements).

HighDesign is available in three different licenses to best suit your needs: LT, Standard and a Pro
version.
is the light-weight, accessible CAD solution for everyone who needs the precision
and power of a full CAD software, without the complexity of more design-oriented features and
tools. HighDesign LT supports the DXF file format.
(Standard Edition) is a CAD program designed to provide the user all the most
used drawing and editing tools. This version is intended for home and small office users who will
benefit from its powerful functions, ease of use and tight integration with the operating system.
HighDesign Standard supports the DXF and DWG file formats.
includes all the features of the Standard version, plus many others designed to
increase personal productivity and satisfy the advanced needs of professional users such as
architects and civil engineers. HighDesign Pro adds sets of design tools such as walls, columns,
doors, windows geared for a professional, intensive use.

The starting place to create a project, open recent documents and choose a template.
The menus include all the available functions and commands in HighDesign.
Learn about the main project window and its sections.
Toolbox
Methods bar
Edit bar
Properties bar
Input bar
The utility panels provide access to important functions like the Project Browser, Layers,
Object Info, and more.
Management and review of units and creation of guides.
Many tools provide an extra panel of settings that are specific of the element class, such as
dimension sizes, annotation shapes, wall components, etc.
Access the most important functions through a graphical menu.

The Welcome window opens by default when you launch HighDesign and presents the options to
create or open a project, open a recent document, choose a template for a new project, or open an
example.

On the right side of the window you can use the quick links to access the Resource Manager
window, the application Preferences window and the Project Settings window. The “What’s
New” button opens the release notes web page of the current version within your default
browser.
The “Guided Tour” button starts a short tutorial that describes and highlights the different
areas of the project window: a popover window explains the corresponding functions of each
area. Use the “Next” and “Back” buttons of the popover window or the arrows of the keyboard
to browse through the different elements of the main window.
When you launch HighDesign after the program did not close properly, the Welcome window
opens with an additional “Recovery” panel listing the auto-saved files. Use this panel to select
the files you wish to open. Once a recovered file has been opened, it is removed from the list.
During the current session, you can access the Recovery panel at any time by opening the
Welcome window from the Help menu.

As in most other applications, this is the horizontal bar placed on the top most edge of the visible
screen area (Mac) or main window (Windows) and contains the following pull-down menus:

, on macOS, this is the standard application menu. It contains the items “About
HighDesign…”, “Preferences”, and the standard application commands such as “Hide” and
“Quit”.
, for file management (open, save, import, export, merge and save special) and print.
, is commonly used for standard commands like undo and redo an operation; cut, copy,
paste and clear; select, invert selection and deselect; search function; arrange and align
items.
: includes command to set the current zoom, display options of pen weights, layers and
drawing. In the Standard and Pro editions, it also includes the display options of sheets. The
Pro edition adds the commands to manage project views.
, for key functions and tools of project organization. This menu includes commands to
manage, create and delete groups, layers, drafting sheets, details, layouts, title blocks and
viewports. Use this menu to access the panes of the Project Settings and Resource Manager
windows.
: this menu lists all the main commands and functions used to modify drawing
elements and to change the drawing scale of the current sheet.
, contains more advanced functions such as “Photogrammetry”, “Render”, “Adjust
Image” and tools used to transform project elements such as “Scale Drawing”, “Fillet”,
“Chamfer”, etc..
, is used to browse through the list of currently opened project windows. Use this
menu to switch between sidebar and floating panels and show or hide individual panels or
rulers and scrollbars.
: access the Welcome window, Guided tour, User Guide, Support links and the Repair
Document and Purge commands.

The main functions of HighDesign are visible and ready to use in the Project Window and in the
surrounding toolbars and Sidebar.
The Drawing Area in the middle of the project window displays the project views and the
sheets used to draw and edit drafting objects and project elements.
The toolbars provide essential functions, such as the drawing tools, the drawing methods, the
input fields and commands, the edit functions, and the properties controls. Through these
commands, arranged in logical areas, all the drawing functions are easily accessible.
The Sidebar provides functions that are mainly used to organize the project and manage
project elements: the Project Browser and the Views panels, the Object Info and the Project
Styles panels.
The Menu bar on the top of the project window displays the menus listing almost all of the
program functions, commands and features.

The Toolbox is placed vertically on the left most edge of the main
window. It contains the buttons to activate all the project
tools. This toolbar is organized in sections:
: select project elements by direct click or by
selection area; modify selected elements
: create and modify 2D drawing elements.
: insert and modify texts, dimensions, text
notes, tags, and define detail areas (standard/pro) and add
temporary measurements.
: create and modify architectural elements like walls,
openings, columns (Pro).
: change the position of the drawing in the canvas via
the panning function, the level of zoom; by preferences
these tools can also be grouped in a dock and displayed on
one side of the drawing area.
To activate a tool, click once on its icon. Some buttons show
three dots in the bottom right corner, meaning those tools
have specific tool options dialogs displayed on the tool
Settings Window. To open the Settings Window and change
a tool settings, double-click on the icon.
Double-clicking the Panning tool (the open hand icon),
activates the Fit To Screen command, and the Zoom tool
(the magnifier icon) resets the zoom of the current view to
100%.
Project tools can also be activated via keyboard shortcuts:
each button has a corresponding key on the keyboard. To
see a tool shortcut, move the mouse cursor over the button
and wait 1-2 seconds until the Tool Tip opens with the name
of the tool and its shortcut.
When you select an object in the project, a color marker on
the tool icon highlights the class of the currently selected
object.
Many project tools have multiple construction methods or
include the options to create related or similar objects (e.g.
the Hatch tool includes the options to create islands within
hatches, whereas the Arcs tool has different construction
methods). These tools with methods have an arrow button
on the right of the tool icon: click the popup arrow to show
the available methods and options.

Tool methods of the currently active tool are also accessible
through the methods bar.
The project tools bar can be arranged on one or two
columns by clicking the expand/collapse button in the
bottom-right corner of the bar. This functionality, however, is
only enabled when there is enough screen room to
accomodate one column of icons.

The Methods Bar displays the construction methods and available options of the current tool, e.g.
Line from one endpoint or from its midpoint, or arc by center, by diameter, by three points, etc. This
bar is contextual and changes its contents according to the selected project tool and can include an
additional input field to quickly insert a parameter value.

Placed on the top margin of the drawing area, the Edit bar lets you quickly access the main
functions used to modify the drawing with just one click on the icon. The buttons are contextually
enabled when the conditions for the use of the tool are met, like number and type of selected
items.

Move
Duplicate
Multiply / Distribute items along a line
Multiply / Distribute items on a circular arc
Rotate
Angle of Rotation
Mirror
Mirror & Duplicate
Stretch
Scale drawing

Find the intersections between two items
Intersect two lines

Extend one or more lines
Split
Trim
Divide into parts
Break

Fillet two lines with an arc
Chamfer two lines with a straight segment
Offset, to create concentric copies of the clicked objects at a given distance
Extrude, to create a copy of the selected objects with projection lines
Explode, to convert the selected items into their base components
Convert to Poly-line
Apply Hatch
Calculate Area
Find Center of Mass
Fit Text box

The Properties bar is located at the top of the main window, just above the horizontal ruler and
below the Edit Bar. You can use it to quickly set the graphical properties of the drawing items and
change those of the selected one.
Layer; Pen color; Fill color, gradient and transparency; Line-type; Start and end
markers; Pen weight; Settings Window button (active when compatible items are selected); Copy
and Paste Properties buttons.

Placed on the bottom of the drawing area the Input Bar provides all the controls to set the drawing
constraints, geometric conditions and input of coordinates, lengths and angles.

The menu to activate the snap options.
The buttons to set the parallel, orthogonal and intersection constraints.
The menu to change the drawing units and the drawing scale of the current sheet.
Input fields: X, Y coordinates, length and angle. When drawing an item, the coordinates
change from absolute to relative coordinates dX and dY. You can switch between absolute

and relative coordinates by clicking the X and Y icons.
The utility buttons and menus, to set the zoom level and the display mode of pen weights.
NOTE: Depending on the available screen size, the appearance and contents of the Input bar can
change. At smaller resolutions, the Snaps menu includes the constraint functions, and the zoom
menu includes the Zoom to Fit, Zoom In, Zoom Out and Zoom Previous commands. The input
fields are always visible.

The Side bar is an area located on the right of the drawing
area that provides important functions designed to help the
user to organize and manage the project: these functions are
easily accessible through panes arranged in the side bar. In
HighDesign SE and Pro the panes of the Side bar can also be
displayed as floating windows.
(Pro)
In HighDesign Pro the Side bar can be customized by using
the commands on the Window menu:
Minimize Side Bar
Panels:
Show as Floating Windows;
Show in Side Bar;
Restore Defaults;
List of all available panels or floating windows.
Panes can be dragged by the titles to change their
position within the Side bar. If you drag them outside the
side bar they change into floating palettes. By right
clicking on the titles of the panes a contextual menu with
the customization options shows up.
To add more panes to the Side Bar just drag the floating
windows onto the side bar.
The button on the right corner above the Side bar allows
to minimize the bar: with this option the bar is collapsed
as a dock on the right margin of the main window. Click
on the titles to expand the corresponding panes.

By default in HighDesign Pro the panes displayed in the Side Bar are Project Browser, Project
Views, Object Info and Project Styles and Types. With other editions of HighDesign the
configuration of the Side Bar is different.

The Project Browser pane lists all the project sheets: drafting sheets, detail sheets and layouts.
Use this pane to manage and organize sheets and to browse the different components of the
project. This pane is not available in HighDesign LT.

The Views pane shows a list of all the saved project views (available in HighDesign Pro only).

The Layers pane shows the layers used in the project and provides the functions to manage them.

The Object Info pane allows to view and edit coordinates and geometric parameters of the
selection. It also allows the setup of the current sheet and to add information.

This pane provides in one handy array the graphic features of project elements, including stroke
and fill attributes: it also provides the Shadow section for a complete setup of the shadow property
of elements.

The Overview utility pane displays a real-time 2x magnification of the sector of the current pointer
location on the drawing area; if the mouse pointer enters the thumbnail, an overview of the entire
drawing is displayed and it is possible to centre the view of the project with a click.

This pane provides all the snap options and the main drawing constraints.

The Arrange panel displays the buttons for all the Arrange Order, Align and Distribute objects
commands.

In HighDesign Pro use this pane to view, browse and manage graphic styles and element types of
the current project.

This is a live preview of the projection of the current photogrammetry (Pro only).

Placed on the left and top of the main window, rulers help drawing and placing objects in a layout
with accuracy. Rulers show the current position of the pointer and the bounds of the selected
objects and are dynamically linked to the current measurement unit, drawing scale and zoom
factor.
The button located on the top-right hand corner between the two rulers lets you place the new
origin: click it, move the orthogonal guides appearing on screen and click to set the new
location.
On the right end of the top horizontal ruler, a button opens a pop-up menu which lets you
select a new measurement unit or open the “Units” pane of the Preferences window.
You can add a horizontal or vertical guide by clicking on a ruler and dragging the pointer on
the drawing area.

Some project tools have more specific options and properties that require an additional window for
their complete setup.
The Settings window can be a multi-panel window and provides access to all the controls to set the
graphic and numeric options of the current drawing tool.
To open this window, double click on one of the drawing tools that show the three dots near the tool
icon: the window will display the corresponding tool settings window.

The Radial Menu in HighDesign opens as a visual array of commands. These commands are
contextual, in that they are only active when appropriate for the current drawing and selection. The
icons are arranged in sections:
“Organize” options;
“Tools” commands;
“Edit Lines” commands;
“Drawing” commands;
“View” options;
“Edit” commands.

This menu does not provide additional commands: it is a different and more effective way to
provide the user with all the most common editing, transformation and organizing commands and
options accessible in the drawing area exactly where you do a click.
To activate the radial menu, right-click or Control+click on the drawing area.

How to access the Preferences window and how to reset to factory settings.
The main preferences with options for language, file safety, undo & redo and support folder.
Options about the theme, global colours, tools and selection.
Drawing mode, snaps and defaults graphical settings.
(Pro)
Customise the keyboard shortcuts for the main menu items and tools.
(Pro)
Organise your templates and set the default for new documents.

The Preferences window allows to set the global options and settings of the application itself, and
personal preferences of the user.
This dialog is used to set the application preferences to customize the work environment, interface
theme and usage options.
On macOS, you can open this dialog by choosing the “Preferences…” item of the
“HighDesign” menu.
On Windows, it is available at Edit

Options.

The Preferences window provides three panes: General, Workspace, and Drawing. The
Professional Edition adds two additional panes, Shortcuts for setting and editing the keyboard
shortcuts, and Templates to save and organize custom project templates.
When you want to
to the default values, launch HighDesign while
holding down the Command (cmd) and Shift keys on the keyboard.

This is the first pane you see when you open HighDesign Preferences: it consists of four sections
displaying the options about general use, file safety, undoable actions and support folder.

The sections of the General pane are:

Choose the user’s language;

Set the option to open the most recent document when the application starts up;
Choose to check for new updates at application launch. Automatic checking only occurs at
application launch and no more than once in 12 hours. If there is no Internet connection
available or there are no new updates, the function is dismissed with no message.

Set and adjust the automatic save options;
Check the option to automatically save a backup copy of the previous version of the
document. This feature provides the option to select the location of the Backups Folder and to
set the maximum number of backup files stored as .zip archives in the Backups folder. In
HighDesign for the Mac App Store it is not possible to select the Backups folder.
Include symbols in saved documents. By default, the symbols you insert in a project are
linked to the original symbol files saved in the Support folder on the user’s disk. By selecting
this option, the symbols used in the project are saved inside the document, making it
independent of the disk. With this option, the file size can increase depending on the number
of symbols used in the project.
Activate the option to send automatic feedback reports to Ilexsoft. When this option is
enabled and the application encounters an error, it will send an anonymous report to Ilexsoft
about the kind of error and the current environment. No personal data will be sent.

Change the maximum number of undoable actions, up to 300 actions;
Activate the automatic undo reset with each save action (excluding the automatic save).

This pane lets you customize your HighDesign work environment. You can:
Switch the interface theme between dark, light and by system (macOS 10.14 Mojave only);
Activate the full size crosshair cursor;
Play sounds during drawing sessions;
Choose not to display help messages;
Use a classic contextual menu instead of the radial menu;
Set the zoom speed when using the scroll wheel and invert the scroll wheel direction;
Enable auto-scrolling on the main window. When this option is on, the drawing scrolls
automatically when, during a construction or editing operation, the cursor is inside the main
canvas near the margins of the main drawing area;
Use the arrow keys to scroll the page and Shift-Arrow for nudging objects;
Activate the long click to pan the drawing; to use the long click, press and hold the mouse or
pad button.
Refresh view during scrolling: when this option is not selected the speed of panning and
scrolling can improve with large and complex projects.
Set the position of the View controls: choose to show the controls in the main toolbar or
grouped in a dock on the margins of the drawing area.
Update default settings for a tool when editing a selected object. E.g. editing the text font of a
selected dimension will set the new font as default for all new dimensions.
Set the default behavior of clicks with the Arrow tool. When this option is active, clicking an
object selects it and deselects any previously selected object; when inactive, clicking an
object adds it to the current selection.

This pane lets you change the options for drawing mode and drawing tools:
Drawing mode, which lets you set the way items are drawn on screen. “Click-Drag” is the
classic Macintosh method of click, hold and release; “Click-Click” is the standard CAD method
of click, release, move, click.
Snap tolerance range, in pixels;
Show/Hide on-screen help tips on snap status;
Show/Hide on-screen info about angle and length of the current vector;
Choose the pen weight display mode from “Hairline” (constant weight), “Bitmap Weight” and
“Print Weight”;
End Caps option – butt, round or square;
Line Join option – mitre, round or bevel;
Disable zooming of pen weights when zooming in;
Show/Hide the axes of the current coordinate system;
Mask the area outside the current page;
Freehand lines smoothing.

Use this pane to assign key commands and customize the shortcuts. It is possible to change
shortcuts for almost all commands of HighDesign menus: File; Edit; Drawing; Tools; Organize;
Window; Drawing Tools.
To change a shortcut, select one or more check-boxes corresponding to Shift, Option and Control
keys, double-click the field on the right and push the new key.

The Templates pane of Preferences allows you to select a template from those already provided in
the HighDesign Library to be opened as default each time you launch HighDesign (architecture and
engineering templates according with the imperial and metric drawing standards, available in two
sheet sizes). You can also save the current drawing, including used layers, sheet size, units and
line-types as a new personal template in the User Library.

Learn how to create a new project and customise it to your needs.
Use the Project Settings window to define all aspects of your new project.
Define a default paper size and print margins.
Set the default drawing units for linear, angular and area values, define the decimal
separator and rounding options.
Your drawing area can show a customisable and scale-sensitive grid.
Choose background and selection colours.
(Pro)
Your project can include a number of non-graphical information about its location, firm,
client, etc.

When you launch HighDesign, the main window opens blank and ready to start a new project. The
default new document is generated using the automatic template.

To create a new project, you can either click the New button on the Welcome window or select File
New. This new project is generated after the automatic template that sets units, colours and other
settings according to the current preferences of language and theme and, when available, the last
document created.
The automatic template includes one layer and a limited set of line-types and hatch-types that you
can later manage and expand according to your needs.
When your project window is ready, the next step is usually to define the specific project settings
such as page format, drawing units, colours and so on. Project settings are specific to the current
document.

You can also create a new project starting from a pre-made template that may include a set of
layers, sheets, line-types and other resources, as well as drawing objects.
To create a new document from a template, switch to the Templates tab of the Welcome window, or
choose File New from Template Chooser… and select the desired template.

Before starting a new project, it is useful to set up the main settings and drawing utilities according
to the drawing standard you wish to use in the current project, such as the paper format and size
and the sheet drawing units.
In HighDesign the Project Settings window, available through the File menu and through the Project
menu, includes the panes to set all the default drawing options specific to the current project.

The Paper Format pane lets you select the default paper size of the entire project from a list of
standard sizes (ISO, ANSI/ASME and US ARCH) and activate the options for Page orientation and
margins. The page standard and size defined in this window is the default for all new layouts.
Once you select the Standard, by clicking on the desired sheet size in the thumbnail, and you
choose the “Margins” option (Current Printer or Custom Margins), a visual aid will be
displayed on screen showing the page extents of the selected size and the corresponding
print margins as a cyan frame: you will use this aid to check if your drawing is entirely within
the margins.
The

section lets you set the page margins that will be visible in all pages of

the project if the Margins option is active.
The default paper format can be overridden by a custom selection in the Paper Size panel that is
available in the Object Info panel. To access the Paper Size pane:

Activate the desired sheet on the Project Browser panel and make sure no object is selected.
The Object Info panel shows the current paper format and size.
Alternatively, double-click the sheet icon on the Project Browser.

You can access this window via the Standard menu to create and manage custom paper sizes. A
custom paper size can have user-defined size and margins, or it can inherit the actual values from
an installed printer. Click the “Define by Printer” button to open the system printer dialog to select a
printer and a paper size.
Saved presets can be renamed, edited and duplicated and deleted at any time. They are also
available in the Paper Size windows of sheets and layouts.

Use this pane to define your preferences for the default, project-wide measurement units for
lengths, angles and surfaces.
The available options are:
Linear units, available as Millimeters, Centimeters, Meters, Kilometers, Decimal Inches, Feet
and Decimal Inches, Decimal Feet, Fractional Inches, Feet and Fractional Inches, Decimal
Yards, Miles, Points and Pixels; the number of decimal digits to be displayed;
Angular units, selectable from Decimal Degrees, Degrees and Minutes, Degrees,
Minutes and Seconds; the number of decimal digits to be displayed when in decimal degrees;
the option to use normal angles, bearings or azimuth; the direction of the North used by
bearings and azimuth directions;
Area units used to express area calculations and values;
The decimal separator to use;
Suppression of zero digits (not available in HighDesign Lt).

You can use this pane to customize the grid and set grid options:
Horizontal and vertical size;
Number of subdivisions;
Grid color: automatic (changes with the current background color) or custom;
Option to display the grid behind or in front of the drawing;
Option to print the grid;
Option to set the snap to grid as exclusive;

A button to show / hide the grid;

This pane lets you customize your HighDesign work environment. You can:
Choose a background color;
Select the color of selection handles;
Choose to highlight selected objects;Choose the color of construction lines: by object
(through the Properties bar) or custom;
Set the line-type of construction lines as continuous or dashed.

Use this pane to add non graphic information to a project, such as author, project name,
description, client name, project location, status or to set an issue date of the project; Project Time
shows you the time you have spent on the project.
Most of these information correspond to the attributes of the Title Blocks and will be automatically
added to the title blocks used in the Layouts of the project.

Setting up the layers used in the project.
(SE/Pro)
Using the Project Browser panel.
(SE/Pro)
What is a drafting sheet and how to use its properties.
(Pro)
Add detail areas to create detailed views of your drawings.
(Pro)
Use layouts to present the project.

A project is a complex set of drawings, symbols, views, details and documentation elements such
as annotations, tags, dimensions and non graphic information. All these elements need to be
organized and arranged in a convenient way. Layers, Drafting Sheets and Details allow to manage
the project effectively.

A layer is a concept used in CAD and design programs to conveniently group elements in a logical
way. As its name implies, this concept derives from the use of overlaid semitransparent papers in
manual drafting. As in manual drafting, layers are used in HighDesign to organize a complex
drawing into different component parts, but, differently from real layers, each CAD layer has its own
properties.
Decomposing a drawing into its components is one of the most important operations in computer
design. Any object, even the most complex, can only be analyzed by separating its elements in
logical groups, applying criteria that depend on the object nature and on the designer goal.

Any element of a drawing in HighDesign belongs to a layer: there is no restriction on what types of
objects you can assign to a layer. You are free to group different elements together in the most
convenient way to you or according to the drawing standard you are following.

Layers are identified by their name;
A layer can be visible or invisible. Items belonging to a visible layer are redrawn to
screen, are printable and selectable; invisible layers are not printed.
Layers can be locked to make their items not selectable.
Layers can have a default 32 bit color. If the byLayer option is on (you can change it by
opening the “Colors” pop-up menu in the Properties bar and selecting “byLayer”), any new
item gets the color of its layer.
. Controls the overall opacity at which the objects on that layer are displayed.
You can create a binding between a drawing tool and a layer so that,
every time you activate that tool, the layer is set automatically. To enable this option, click the
corresponding check box. The Tool column on the main table will become active. Click the
icon on a row to select a tool or method to associate with that layer.

The layers of the project are listed on the Layers menu of the Properties Bar: select the desired
layer by a click to update the current default or to change the layer of the selection.
The name of the current layer or of the layer of the selection is shown on the menu.
The Layers menu displays the main functions to manage layers: you can switch to other
layers, show or hide layers, lock some layers and access the Layers Manager to create and
arrange new layers.
The commands on the upper section of the menu allow to create new layers, open the Layers
pane of the Resource Manager window and switch layer masking on and off.
You can mask the layers of a project so that only the current layer is visible and editable.
Masking is a switch on/off command, and as long as the mask is active, changing the current
layer will automatically hide the other layers. Once masking is switched off, the other layers
return to the original visibility they had before the command.
Layers are document based and are only available to the project you created them for.
In addition to the pop-up menu, you can manage project layers with the Layers panel,
available under the Window menu, or with the Resource Manager.

The Project Browser shows a logical hierarchy for all the Drafting Sheets of the project and also
lists Details and Layouts which are special sheets used to present the project. By using this panel

you can quickly create, rename and delete sheets, change their visibility, protection, optional size
and scale attributes.

To create a new sheet, click the New Sheet button (+) and modify its name. By default, new sheets
are created with the current drawing scale and units. You can change the units and scale of a sheet
by double-clicking it on this window.
To arrange a sheet, drag it to the new position: the table order corresponds to the actual display
order, where the topmost visible sheet is the first item of the list.
You can control how the sheets are displayed on screen by clicking the Opacity button. There are
three states: all sheets equally visible, the current sheet displayed normally and the others dimmed,
or only the current sheet visible.

The Project Browser panel provides several buttons on the footer of the window to quickly access
functions and set options.
New sheet: adds a new sheet at the top of the list; new sheets have a default progressive
name which can be changed by double-click.
Delete selected sheet: all objects of the current sheet can be moved to another one or
deleted.
Action menu. The action menu lists the commands to manage sheets as in the Project menu,
apart from those specific to the selected objects of the drawing, and the commands to change

the visibility status of all sheets in relation to the current one.
Display modes: All Visible, Dim Others, or Hide Others.

As it is in manual drafting, a project is made of different sheets, each with its own page size,
drawing scale and units, depending on the part of the project it represents. HighDesign provides an
intuitive way of handling projects by introducing the concept of “Drafting Sheets.”
A Drafting Sheet in HighDesign has special attributes such as visibility, write-protection, etc.,
that make it a convenient way of organizing a project: you can, for instance, put a different
drawing on each sheet or use a sheet for the main drawing and draw sections on additional
sheets.
A HighDesign project, either for architecture, engineering or design, is thus made up of
several drawings contained in a single document.
The ability to show or hide sheets, transparency and write protection allows you to compose a
complex project even in a single layout.
The following are some of the properties and advantages sheets provide:
Independent drawing scale and optional paper size of the current sheet;
Independent drawing units;
Write protection and display mode (visible, hidden and dimmed);
You can search and select items on a single sheet or on all sheets;
Visible sheets can be merged into one;
You can create and delete any number of sheets;
The print functions only prints the visible sheets;
A sheet can be saved as a new document;
Sheets can be reordered and renamed; two or more sheets can share the same name;
Drafting Sheets are managed through the Project Browser Panel of the Sidebar and via the Project
menu, which provide all the commands to create, rename, delete and reorder sheets, move and
duplicate items across sheets, show and hide, etc.

From left to right, the properties of a drafting sheet accessible through the Project Browser are:
Visibility, on or off;
Optional Paper Size: double-click the page icon or use the Object Info panel to change the
paper size of the current sheet;
Name: double-click to rename the selected sheet;

Sheet Protection: click to switch; protected sheets are visible but are invisible to the snap;
Drawing scale and units: click to open the units and scale menu.

Detail Sheets are specialized drafting sheets used to add detailed views of the project. This class of
sheets allows a better organization of the project by separating the drawing sheets, where the
project is, from the other drawings that complement the main design. Details are typically
“extracted” from a larger design and include additional elements and information, usually at a larger
scale.
There are two methods for creating a detail sheet: by detail area and as an independent detail.

1. Go to the drafting sheet where the desired drawing is and create a detail area on the part of
the drawing from which the detail is going to be generated.
2. Select the detail area, click the drop-down triangle next to the area’s title and choose New
Detail by Selected Area.

3. In the dialog, enter the name of the detail sheet and define its scale and units. The Show
Texts switch controls the visibility of texts, dimensions and other annotations in the detail. All
these options can also be set later in the Object Info panel.

The new detail sheet by default shows the drawing contained in the source area. This is called
“underlay” and it can be toggled on and off and displayed at the desired opacity. The underlay
serves as a reference for further drawing and automatically updates whenever the original drawing
is changed. The objects that are visible on the underlay can be snapped, but cannot be selected.

1. On the Project Browser, click the plus (+) icon on the Details group heading or choose Project
> New Independent Detail…
2. Define the sheet’s properties in the pop-up dialog.
3. Independent details are not linked to a detail area and show no underlay.
Detail sheets support a sub-set of the drawing tools: you can use sketching and documentation
tools, but design tools as Walls or Windows are not available.

In linked details, the underlay can be exploded and turned into a group for editing and further
transformations: to explode the underlay use the menu item Project > Explode Underlay.
The Object Info panel provides the main information and the options of the current Detail. Details
do not have the Paper Size option. To add a detail to a layout, create a viewport on the layout and
choose the detail as source sheet for that viewport.

Once a detail area is linked to a detail sheet, it becomes a
marker that contains information about the detail:

. Callouts have an additional

the upper half shows the identification number of the linked detail sheet.
the lower half shows the layout identification number where that detail has been placed as a
viewport.
When the detail area is selected, you can click either of the labels in the callout mark to go directly
to the linked sheet.
Further information about detail areas is available on the chapter Annotate the Project.

Layouts are special sheets used to display the various drawings of the project. Think of layouts as
the presentation sheets that are going to be published and shown to the client.
Layouts are always at 1:1 scale, can contain their own drawings and annotations, such as tables
and text blocks, and can display drawings taken from the main design inside scaled windows called
viewports.
By using layouts, you can separate the model, that is the actual project you are working on, from its
representation. More information about layouts is at the chapter Present the Project with Layouts.

All the functions needed to correctly manage your documents are available in the “File” menu, and
many of them are easy to understand as they are standard commands in all applications.

Through this function you can use an existing template for the new project: this preset includes
properties like units, sheet size, layers, line-types, hatches, title blocks and graphic objects. Default
templates are available with the imperial and metric drawing standards of architecture and
engineering.

To open a HighDesign project stored in a known location, select File
quickly open a recently modified document, choose

Open…; if you want to
.

The “Open…” command also lets you convert and open “.dsn” files from previous versions of
HighDesign.

Select
to open a project inside the current one: the merged project will contain
layers, sheets and symbols from both source projects.

HighDesign lets you easily add pictures to your project from several graphic formats (TIFF, JPEG,
PNG, GIF, PDF). Images inserted into the project keep their resolution and are displayed at the real
print size: it is also possible to handle them as any other vector entity. PNG and TIFF images are
imported with their alpha channel if present.
To insert a picture in your project, select
, choose the image and place it at
the desired position with a click. Alternatively, you can drag an image from another application,
such as a web browser, drag a file directly onto the drawing canvas, or use the Paste command to
paste an image from the clipboard.
PDF documents can be inserted as high-resolution images. When you choose a PDF document
with the Insert Image command, you are presented with a dialog where in you can select the page
to import, if more than one, and set the resolution at which the image object will be created.
If you use the Pro version of HighDesign, you can also enhance the image by adjusting brightness,
contrast, saturation, size, sharpness, smoothing factor, etc. To set size on screen, print size,
resolution and transparency of images, use the Image Settings window on the Edit menu.

The
menu includes all the basic functions to save the current document to the desired storage
location:
lets you save on disk the current project; if the project does not have a name, a
standard save dialog is shown on the screen.
… saves a copy of the current document with a new name;
has a sub-menu:
saves the currently selected items into a new file;
(Pro version only), saves a copy of the current sheet into a new
file;
(Pro), saves only the sheets that are currently visible;
: older releases of HighDesign may not open newer
projects correctly or at all. This command lets you save the current project in the file format of
one of the previous releases.

(Pro version only) stores the current properties and graphic objects as a reusable
template.
HighDesign Projects have the “.dsn” file name extension.
It is possible to import projects saved by other CAD programs by using the DWG/DXF file format,
which HighDesign supports from version R9 to 2018-2020. Import and export commands are
described in the Import and Export chapter.

Open and convert drawings in the DWG or DXF file formats.
I
Convert collections of blocks into HighDesign symbols.
Save your project in another file format.

Select
the basic import settings:

. Before opening a DXF/DWG file a dialog lets you set

Drawing units to be used to convert DXF/DWG elements; most DXF/DWG versions do not
include a measurement unit;
Destination scale of the drawing;
When the “Use file drawings units” option is active, HighDesign tries to set the drawing units
as found in the file. If no drawing unit is found this option has no effect;
Options to set the background color to black or to add a prefix to layers;
HighDesign SE and Pro import DWG/DXF documents with both Layouts and Model data: when
opening the document, the drawing, or Model, is located on the sheet named “Model”. In
HighDesign SE, layout sheets are imported as drafting sheets with a defined paper format; in
HighDesign Pro, the Layout objects are imported into layout sheets.
HighDesign Lt only imports the Model space. Layouts are ignored.

In HighDesign SE and Pro, use the Project Insert DWG/DXF drawing menu item to insert a
DWG/DXF drawing into the current project without creating a new document. This command will
add a new drafting sheet with the Model space from the specified drawing.

Use the “Import DWG/DXF Blocks” tool to convert a folder of DXF/DWG blocks or drawings to
HighDesign-native symbols. Converting a symbol library is a two-step process, all performed in a
single window.
Choose

; the following window opens:

1. Conversion options – convert blocks/drawings within one folder or blocks within one
DWG/DXF file. Push the Choose button
2. When the import process is complete, you can use the table to review and edit the imported
symbols.
3. Preview of the symbol.
4. Click the Convert button to save the HighDesign symbols into your current Library folder.
The list of symbols can be reordered by dragging the rows.
The first step consists of selecting the folder on your disk and importing all the readable drawings
contained in it. Supported formats are all DXF versions from R10 to 2020 and all DWG versions
from R9 to 2020 (DWG support only available in HighDesign Standard and Pro).
Push the Import button to choose the folder. If the selected folder contains readable files, the
standard DXF/DWG Import dialog opens allowing you to set the scale and drawing unit options.
With the second step you can set the options and complete the conversion to HighDesign symbols.
The table displays name, scale, width, height and the preview of each symbol, letting you modify
the attributes of the symbol before it is saved.

It is possible to extend your Symbols library by creating new custom symbols or by adding external
libraries: the “
” command on the File menu lets you select a folder of
HighDesign symbols and copy them to the desired folder in the User Library folder.

Your project can be exported to many graphic formats. Select
destination file format:
DWG file format from version R12 to 2018-2020 (.dwg).

and choose the

DXF file format from version R12 to 2018-2020 (.dxf).
DXB (.dxb) versions R12-2018-2020.
Vector PDF (.pdf) – (Pro only).
TIFF (.tif).
JPEG (.jpg). When you export a drawing to JPEG, a dialog lets you set the compression
quality and JPEG specific attributes. On the right half of this dialog, a preview shows the new
file and the original image.
PNG (.png). PNG supports high DPI and provides the option to export with the Alpha channel.
Alpha channels are 8-bit masks that make the final image transparent. In HighDesign, a PNG
with alpha channel is a transparent image with no background.
GIF (.gif).
BMP (Windows Bitmap).

Format version via a pop-up menu. Also available in HighDesign Standard;
List of sheets of the HighDesign project and ability to select Drafting Sheets, Details and
Layouts to export;
Option to export all selected sheets as a single DWG/DXF document;
Option to export each selected sheet as a separate document (all documents are collected in
one folder).

The print function produces high quality prints on any page format supported by your printer.
The basic concept behind printing in HighDesign is “what you see is what you get”, meaning that
not only the printed page will look as much as possible as the drawing on screen, but also that no
scaling, hiding or other operations are required in order to print the drawing. If the project includes
sheets at different scales, they will be printed with the same relative proportions.
All print operations are performed by selecting one of the print items in the “File” menu.
: opens the standard page setup dialog of your Operating System. Use this dialog
to select the printer and set page size and orientation.
: opens a dialog to set HighDesign specific print settings and get information about
actual drawing extents and number of pages that will be printed.
Some items of the project are not printable: Detail Area frames and Selection handles.
Construction objects such as datum points, grid, and construction lines can be printed if the “Print
Construction Objects” checkbox in the Print dialog is active.

This window contains the Project View pop-up menu, to choose the view you want to be printed
with its corresponding set of visible sheets and layers (Pro-only feature), the Layout pop-up menu,
used to set the position of the printed drawing relative to the pages, and the Printable Area pop-up
menu, providing a list of possible print options. Available options are:
Whole drawing: prints all items on visible sheets and layers;
Selected items: only prints currently selected items;
Detail Areas: from a list of available Detail Areas, this options only prints the region of drawing
included within the bounds of the selected area.
The Print button opens your printer’s Print Settings dialog. This dialog may include different panes
for each printer manufacturer.

. Use this menu to select the current view, a saved project View to automatically show
and hide sheets and layers accordingly, or a Layout.
. Options of this menu are: Whole Drawing, to print all the visible objects in the drawing;
Selected Items, to print only the objects currently selected; any available detail areas created
with the Detail Area tool.
Actual extents of the drawing being printed and number of pages required to print the drawing
(rows x columns).
menu, showing the options to lay out the drawing within the page.
of the printed page.
menu. Set the print resolution from 180 to 1200 dpi (600 dpi is the default).
field to set custom reduction/enlargement factors. The checkbox Fit To One Page
calculates the best scaling factor to print the entire drawing on one page.
menu. Lists the options to print by project color settings and to print all colors as
monochromatic through the colors menu. Sub-options are the ability to exclude fill colors and
to disable the color interpolation of stroke lines. This last option allows to print the drawing
with a fixed color regardless of the brightness of the original color in the drawing.
:
Print pen-weights option: uncheck to print everything as thin lines.
Scale Pen-weights. When “Fit to one page” is set, the Scale pen weights option allows you to
choose whether the pen weights should be scaled to match the new zoom factor of the
printout.
Print margins: if checked, small marks are printed at the corners of the available printable
area on each page.
Print construction objects: if selected, construction points and lines of the selected view will
be printed.

Snap to grid, object, vertex
Parallel, perpendicular, tangent, aligned
Draw at fixed coordinates, length, distance and angle
Adjust the current view

Snapping is a function that allows the precise positioning of objects and insertion points by having
some points of the canvas or parts of objects attract the cursor. It behaves like a magnetic property
that adjusts the cursor position when it is within a certain range. HighDesign provides automatic
snap to grid nodes, object body, vertex, intersection, right-angle / tangent and alignments.
Snaps can be toggled on and off through the Snaps menu on the bottom-left hand side of the main
window in the Input Bar. Snap options can also be displayed as a handy floating window available
via the Window menu.

The Snap function is always highlighted by a different shape of the pointer and marked by a handle
on the screen that correspond to the current snap condition. Depending on the current preferences,
the type of snap can also be highlighted by an on-screen label and a sound.
The available snap options correspond to the following snap types:

Snap to grid: the pointer snaps to grid intersections and its sub-divisions;
Snap to endpoint or vertex;
Snap to object: the pointer recognises a minimum distance from an object body;
Snap to intersection: all intersections are interpreted as endpoints;
Snap to right-angle: the pointer changes when the current segment intersects another one
with a right angle;
Snap to tangent: the pointer changes when the current line is tangent to a circle / arc;
Snap to alignments: the pointer snaps to two temporary guides;
Snap to Sub-Objects: allows to snap to the objects inside the instances of symbols inserted
into the project and inside the Viewports inserted in Layouts.

When the pointer snaps to one endpoint of an object, that location is stored as current origin of the
temporary guides; the guides are displayed when the cursor is on the X-axis or Y-axis of that datum
point.
The pointer also snaps to the intersection of the guides: the intersection is highlighted with one
point and both the guides visible.

Furthermore, when you place the pointer over a segment, this function stores the angle of that
segment displaying the corresponding parallel and orthogonal guides: when tracing the line, just
place the pointer over one datum point of that segment (endpoints or midpoint) to display the
alignment.
To temporarily disable the Snap to alignments, hold the “cmd” key (Mac) or “ctrl” (Windows).

The Drawing Constraint functions allow you to quickly draw items with some conditions, such as
parallelism, defined angle or intersections. The Input Fields on the Input Bar allow you to enter the
coordinates of drawing points and the geometric dimensions of the objects, like length and angle.

Linear or polygonal graphic objects such as lines and Poly-lines, rotated rectangles, hatches, arcs
and ellipses by radius and diameter, dimensions and walls, can be drawn aligned with one of the
Cartesian Axes or rotated by steps of 15 degrees: to do this, just press the Shift key while moving
the pointer.

These three buttons on the Input Bar provide the Right-Angle and Parallel constraints and the
Intersected condition.

These conditions can be activated anytime with any tool or editing function and will affect the
direction of the current movement.
To activate the Right-Angle or Parallel condition:
After the first click of the current operation you are performing, click the button corresponding
to the desired condition or press its keyboard equivalent (P or R);
Click the reference object, e.g. the line you want to draw perpendicular or parallel to (the
mouse-cursor changes to a pointing hand when on a valid object);
To cancel a condition, press the Esc key on the keyboard.

This condition constrains the pointer to intersect a reference line or circle, extending the line you
are drawing to the intersection point, even outside the segment bounds, or constraining the
direction to the tangent.
To activate this condition, click the button in the Input Bar or press its keyboard equivalent. If the
condition is activated before the start point is defined, it constrains the start point to be aligned to
the line or tangent to the circle. If activated after the first click, it constrains the end point.
The same result can be achieved by pressing the Command key + click on the datum line while
drawing the line, polygon, wall or hatch/fill.
The Constrain Tangent option can be activated to construct a line tangent to an arc or circle, either
from the starting point or to the end point.

1. Activate the Constrain Tangent option.
2. Click on the reference arc or circle. As you move the pointer, the start point of the segment
will keep the tangent condition that is closest to the clicked point.

1. Click to define the start point of the line.
2. Activate the Constrain Tangent option.
3. Click on the reference arc or circle.
The drawing constraints and the snap options can also be displayed as grouped in a floating
window you can move to a convenient position on the screen. To show this option, select “Snaps”
on the Window menu.

The Input fields are grouped together in the middle of the Input Bar: use these fields to enter the
values of constrained coordinates, length and angle of the object you are drawing. The X, Y and L
fields also support additions of partial values.
When you click on one field or use the keyboard shortcut, a visual aid shows up to point the current
constraint out.
In all input fields, values can be entered either as numbers, such as “100”, or as a sum of numbers,
such as “100+20+60”.

Coordinates in HighDesign are either absolute or relative. Absolute coordinates are calculated from
the global origin point of the drawing, and relative coordinates are calculated from the previous
point of the object.
The insertion point of an object, that is its start point, is always set and viewed in absolute
coordinates, with the X and Y values calculated from the origin of the current sheet. The next point
is relative by default, but you can change it from relative to absolute by clicking the X or Y icon on
the input field.
For example, in a line with points at (20, 20) and (100, 100), the end point is (100, 100) in absolute
coordinates and (80, 80) in relative coordinates.

1. Click on the corresponding input field or press the “X” or “Y” keys on the keyboard;
2. Enter the desired X or Y distance from the Origin;
3. Press Return to confirm.

1. Click on the coordinates fields or press the “X” or “Y” keys on the keyboard;
2. Enter the desired dx or dy distance from the start point;
3. Press Return to confirm.

You can change from relative to absolute coordinates and vice-versa by clicking the X or Y icon on
the input field or using the corresponding key shortcuts.

You can constrain a segment, line or radius to a fixed length after you have set the start point. In
HighDesign, there are two methods for constraining a length that can be used interchangeably.

1. After the insertion point is set, move the pointer at the desired angle of the next point;
2. Enter the desired length, either as a total length or as a sum of partial values;
3. Press Return to confirm;

1. Click on the Length field or push the “L” key on the keyboard;
2. Enter the desired length;
3. Press Return to confirm;
4. Move the pointer to set the angle of the vector.

To constrain the pointer movement to a fixed angle:

1. Click on the “A” field (Angle) or push the “A” key on the keyboard;
2. Enter the desired angle value (in degrees);
3. Press Return to confirm;
4. Move the pointer to set the desired length.

It is possible to constrain the pointer to a relative angle to a reference direction:
1. Click on the “A” field or push the “A” key on the keyboard;
2. Enter the desired angle value (do not push the “Enter” key);
3. Click on the reference direction (line, poly-line segment or wall);
4. Move the pointer to set the destination length.

To set the distance of the insertion/start point of an object from a datum point, type the value, push
Enter and click on the datum point; the distance is now displayed as a radius from the datum point:
click to set the insertion/start point of the object.

Drawing constraints for X and Y coordinates, Length and Angle can also be activated by pressing
the Tab key on the keyboard. When you first push that key it activates the X constraint; then, in
order, Y, L, A. Activating the Y constraint stores any values inserted into the X field, so to make it
easier to set the coordinates of a point.

These viewing tools, by default grouped in a handy dock on the border of the drawing area, are
essential to handle drawings. The first time you launch HighDesign Panning, Zoom and Zoom to fit

are docked as semi-transparent buttons on the top right corner of the drawing area: by right-clicking
on the dock you can open a menu with the options to change the position of the dock.
Also, in the Zoom and Scrolling section of the Workspace pane of HighDesign Preferences you can
open the “View controls” menu to change the position of the dock or to display the controls in the
main toolbar.

The Zoom tool allows you to enlarge or reduce the current view of the drawing by zooming in or
out.
Click on the start point, then move the pointer and click again the define the rectangular area that
will be zoomed. Hold down the Option key to zoom out.
The zoom factor is inversely proportional to the size of the zoom rectangle, that is, the smaller the
rectangle is, the higher will be the factor.
Double-click the tool icon to set the view factor back to 100% (actual view).
Other zoom commands are grouped under the View menu, including “Zoom to Fit”, “Zoom In” and
“Zoom Out”.
Dynamic zoom is enabled by pressing “cmd and +” or “cmd and -” buttons on the keyboard or, with
a multi-button mouse, by rotating the wheel: rotate the wheel forward to zoom in and backward to
zoom out. Trackpad gestures are also supported by the dynamic zoom.

This viewing utility control is also available as a button in the dock of the viewing tools: by clicking
this button the zoom factor and the center of the view are adjusted to fit the extents of the drawing
area. This way you get a panoramic view of the whole visible drawing.
When one or more objects are selected this control centers the view of the selection only.

Use this tool to drag the drawing area and quickly move the current view. To use the Panning Tool
click and drag the mouse pointer.
Double-click the tool icon to set the view to the center of the drawing.
The panning tool can also be temporarily activated with any tool by pressing the space bar on the
keyboard: if you already started a task, for instance drawing a line, the use of the panning tool will
not interfere with the current function.
With a multi-button mouse it is possible to pan the drawing by clicking the middle / wheel button
and dragging the pointer.

Its main purpose and type of information displayed
View and choose one of the selected objects
Coordinates of the current vertex
Size and geometric properties
Information associated with the element

The Object Info panel provides easy access to coordinates and other geometric parameters and to
textual information of the selected objects. If no graphic objects are selected the Object Info panel
provides all the information about the current sheet.
You can use this panel to read and edit the coordinates of any of the control points of the object,
width, height, length, angle, etc., according to the type of object, and its information if available.

The Object Info panel is the main interface to setup the current sheet, detail or layout: the different
sections of the panel provide all the controls and fields needed to set name, scale, units, page size,
graphic options and other information.

The panel is organised into distinct sections that group together affine data and vary depending on
the item currently displayed:

When no object is selected, Object Info shows the information relative to the current sheet.
Header: sheet class
Sheet: name, options, scale and units
Paper size: visible for sheets that support a paper size
Class-specific settings

Header: object class
Point, available to all graphic objects;
Geometry, for all graphic objects;
ID for elements.

The header section of the panel shows the icon and class of the current item.
When you select one or more objects in the drawing, Object Info immediately displays all the
numerical properties of the last selected object. The icon and name of the current object are
displayed on the top bar of the window, along with the back and forward arrows used to
browse through the objects in the selection.
Some objects like symbols, texts, dimensions or walls have special settings that are not
displayed on the Object Info panel: when one of these objects is selected it is possible to

open its Settings window by clicking the icon on the top bar of Object Info or via the Show
Settings button in the ID section.
By default, Object Info modifies all the selected objects of the same type. To modify only the current
object, whose values are displayed on the panel, open the pop-up menu on the header and choose
“Apply Only to Current Object”. This option stays selected until changed again.
With multiple selections, use the back and forward buttons on the right to activate the current
object.

The Point section displays the X, Y and Z coordinates of the current point. The current point is
highlighted in the drawing, and you can use the back and forward buttons to scroll through the
handle points of the object. To change a value, click the field, insert the new value and press the
Return key on the keyboard.

Depending on the type of object and the active point, the resulting action of editing the
coordinates of the active point can either be a stretch or a translation. For instance, if you edit
Point 2 of a line, it is stretched; if you edit Point 3 of a circle (its center), the action is a
translation.
When a rectangle or a polygon is selected, this section shows the kind of transformation
compatible with the current active point. With poly-lines it is possible to modify the convexity
of the segment described by the active point.

The Geometry section displays values describing the size and orientation of the object, like width,
height, radius, length, angle, etc.. Fields like Width and Height can be connected to constrain the
proportions of the object.
This section also displays read-only values that are computed by the current coordinates and size,
like perimeter and area.
Some objects, like dimensions and measure paths, only display their value in a read-only field,
since they are actually dependent on other objects for their size. Walls add some controls for quick
construction changes.

This section is specific to project elements that have advanced properties (accessible through a
Settings window) and shows textual information associated with the object, such as name,
description and Id that are used, for example, by annotation elements or title blocks.
This section also includes the button to open the Settings window of the selected object.

Most of the attributes common to all object types can be set and changed in the Properties Bar and
in the Graphic Atributes panel. Properties that are shared among most object types are: layer, pen
color, fill color, pen line types, start and end markers, pen weight, shadow.
To set the properties for new items, make sure no object is selected and then use the controls on
the bar or in the panel. To edit the properties of an object, select it and then change the
corresponding values.
Graphic properties specific of some objects, such as extension lines of dimensions or hatches and
fill color of walls, are managed through their Settings window.

The Graphic Attributes panel supplies the graphic features of project elements, including stroke and
fill attributes: it also provides the Shadow settings section. Information about Layers are not listed in
this panel.

The
section contains Pen color and Line-type menus, Start arrow and End arrow options,
the Pen weights menu and the Cap and Line Join options of linear elements.
The
section displays the Fill color pop-up menu and the Opacity control to change the global
opacity of the fill.
The
section provides the options to customise this graphic attribute of objects. Clicking the
switch button enables the shadow attribute and its options as well.

Although layers are not graphic attributes per se, yet they can alter the visual properties of their
objects significantly and thus mentioned here. The Properties bar includes the Layers menu which
you can use to quickly set the current layer, change its options and set the layer of the selected
objects. More options are available on the Layers panel and the Layers Manager window.

Use the Pen Color pop-up menu to select the current pen color or change the color of selected
items. Pen color controls the color of the outline of objects.

Pen color can be selected as:
By layer: the object uses the color defined by its layer.
Contrast: a variable color that always contrasts with the background of the page. On printouts
it is always black as the background of the paper is assumed to be white.
None: makes the outline of the object invisible.
Indexed color: you can select any color from any active palette. Recently used colors are
listed in the Recent items section. This section is always relative to the current project and is
empty in new documents.
The Resource Manager icon on the top opens the Colors & Pens Manager panel: use this panel to
add new palettes or associate pens and colors.

The Fill Colour pop-up menu controls the options for filling a shape with a colour or a gradient. The
button is active only for objects that have the fill property, like poly-lines, polygons, fills, arcs, circles
and ellipses curves and walls.
The fill property of shapes and elements can use one of the following methods:
Indexed colour
Custom colour
Gradient
Use the navigation icons on the top hand side of the panel to access the sections, in order, for
palettes, the custom colour selector and the gradient editor.

The Palettes tab works in the same way as the Stroke Colour panel: choose a colour from any of
the active palettes to use it as fill colour. Any associated pen weights are ignored.
The Palettes tab on the Fill popup also includes an Opacity slider that controls the overall opacity of
the fill.

In addition to indexed colours, you can also define a custom colour. The Colour pane includes the
following items:
No colour button: press this button to remove the fill.
Colour value selector: the rectangular area at the centre of the panel shows the current colour
in varying degrees of saturation and intensity. In the HSV colour model, this selector controls
the S (saturation) and V (value or brightness) values.
Colour hue bar: the multi-coloured bar below the value selector allows to select the desired
shade of colour.
Opacity bar: controls the transparency of the colour in a range from 0 (completely
transparent) to 100 (completely opaque).
System picker button: the multi-coloured circle at the left allows you to define colour using the
system colour picker.
Value fields: these fields show the numeric representation of the colour in hexadecimal format
(HEX), in the current colour model (HSV, RGB, CMY), and the opacity value. Click one of the
HSV/RGB/CMY labels to switch the current colour model.
The Opacity slider at the bottom hand side of the panel controls the overall opacity of the fill and is
independent from the colour opacity.

The gradient button on the Fill menu opens the Gradient Editor. A gradient is a fill that varies its
color from a start color to an end color, with variable opacity. Available gradient types are
(or
axial) and
, and can be activated through the buttons on the top left hand corner of the
window. The
button, inverts the order of the colors in the gradient slider.
The

and field control the angle between the start and end points of the gradient.

The
controls the “color stops”, that is the colors and their locations along the axis.
Select a color to use the color picker and adjust its values and opacity; click on the slider to add a
color; drag a color along the slider to change its location; click the “x” button to remove the selected
color of the gradient.
Changes are visible in real time.
The geometry of a gradient, that is position of the handles (end points) and radius of the circle
(for radial gradients), can be edited by selecting an object with a gradient and adjusting the
handles on screen.
The Presets section at the bottom provides default gradients and the option to save the
current settings as a preset that can be reused in the project.
Click the “No Color” button to cancel the fill/gradient attribute.

A linear gradient is an interpolation of color that varies along a line between two defined points.
When you select an object with a linear gradient, a line with two endpoints marks the linear
gradient. You can edit each point and adjust the gradient as needed.

A radial gradient is a fill consisting of a progressive transition between two or more colors that
radiate from an origin. Once created, the gradient has its origin, corresponding to the start color, in
the center of the filled object and its end color in the nearest border or side of the object, describing
the radius of the gradient.
To edit the gradient move and adjust the circle visible when the filled object is selected: move the
start point or center of the gradient, marked with a square handle, to move the gradient and move
the end point to adjust the radius.

Due to the underlying graphics engine, gradient colors with varying opacity cannot be
printed or saved as PDF. On print or PDF, such gradients are rendered with an opacity value of
100%. Anyway, it is possible to change the global opacity of the fill through the Opacity control of
the Graphic Attributes panel: this way the global opacity of gradients can be exported as PDF. Also,
for output consider image formats such as TIFF, PNG or JPEG.

Use the Line-type pop-up menu to set the current line type or edit selected items (when applicable).
This pop-up menu lists all currently loaded line-types, each with its own index number.
Apart from the Continuous line type, all other lines have the Line Scale Factor, expressed in
percentage, to proportionally modify the size of dash and space and the extent of special lines.
The Line-type menu also provides the option to open the Line-type Manager pane of the Resource
Manager window to manage existing line-types or to create new ones.

Object vertices, such as lines, poly-lines, ovals, etc., can have arrows and other markers.
To set or edit the current object marker, use the two marker pop-up menus: the left one controls the
start point of an object (Start arrow), and the right one controls end points (End arrow).
A slider on the bottom of the menu allows you to set the size of the arrowhead.

Use this pop-up menu to set and edit the current pen weight from a list of 22 different values,
expressed in millimeters.
To change an item’s weight, select it and choose the new weight from the menu.
Because of the resolution of the screen (72 dpi), pen weights cannot be displayed on screen
exactly as they look on printouts; when the Actual (print size) Pen Weights mode is on,
HighDesign displays the different pens on screen with an approximation to their real print
size. When the Bitmap mode is active, pen weights are displayed with a simple progressive
pixel size.
To change the way pen weights are displayed on screen, open the HighDesign Preferences
window, select the Drawing pane and choose one of the three options available for pen
weights or click the button on the lower right hand side of the main window.
In printouts with low quality paper, pen weights may be a bit different from those chosen on
the menu. The optimal print resolution is 600 dpi on high quality paper.

The graphic elements of the project can have shadows, managed through the Shadow section of
the Graphic Attributes panel. Shadows are applied to the single elements by clicking the switch of
the section.

The options include:

pop-up menu and opacity control.
control, to set the direction of the shadow.
of the shadow (you can choose “By Project”, using the project scale and units or
“Pixels”, using real scale graphic units).
to soften the edge of the shadow by changing its range.

With this command all the properties of the selected item are copied and stored for later use. This
function applies to layer, color, line-type, weight and arrowheads. Copied properties can then be
applied to other items of the drawing.
This tool can also be used via a keyboard equivalent: Option-click an item to activate it.
When you have copied the properties from an object, you can apply them to other objects. When
the pointer is over an item the cursor changes to a paint bucket: click to apply the properties to that
item. Click in a void region to quit the Paste Properties tool.
This tool can also be used via a keyboard equivalent: Command-Option-click (Mac) or Ctrl-Alt-Click
(Windows).

What is a style and what it is its use
Styles for graphic objects
Styles for design elements
Create, edit and manage styles

A style is a named, predefined set of information, properties and behaviours that can be applied to
multiple graphic objects or architectural elements in a project. Styles can be used for classification
and organisation purposes. Think of styles as templates that describe certain properties that are
common to all the instance objects that have the same style. The specifications defined by a style
are applied to all the occurrences of that class in the project and modifying a style will also modify
all the objects in the project that use that style. In brief:
Style = a template of properties and attributes.
Instance object = an individual item in the project that can have a style and use the set of
properties defined in it.
In relation to styles, an instance object can have:
this is a custom item and is unique in the project.

the properties of this object are governed by its style. Changing the style will also
update all the objects that use it.
the object uses a style, but one of its properties is different from that defined
in the style. Objects with a modified style can be reverted to match their style.
Styles can be created directly in the project, for example using an existing object as prototype, or
can be added to the project from a library. When a style is added to the project from a library, it is
actually copied into the project so that any modifications to its properties are only applied to that
particular project and do not affect other projects.
Though you can create a project without using styles and add only unstyled elements, it is
nonetheless a recommended practice to reduce the number of custom elements to the minimum in
order to increase the efficiency and scalability of the project.
Styles in HighDesign can be of two classes:
, that are applied to 2D drafting objects and define their graphic attributes.
, applied to architectural elements. Types always include properties
and information specific to the class of architectural elements they were created for.

A graphic style can store the current settings of layer, pen and fill colour, arrow-heads, line-type,
pen-weight and shadow. A graphic style can also include the settings specific to a class of
elements, such as, for example, text font and size, or hatch pattern. When you create or edit the
style, you decide which attributes should be included and thus applied to the objects.
Graphic Styles are classified as:
These are generic styles and can be applied to simple drafting objects,
including construction objects, lines, poly-lines, rectangles and polygons, arcs, circles and
ellipses and curves: existing basic styles can also be loaded by building element types as
predefined graphic properties. Properties that are not supported in a class of objects are
ignored (e.g. the fill color property is ignored by lines).
, that apply only to specific drafting objects with their own tool
settings; these styles are connected to the objects they are created for: when you select a
specific style, the corresponding tool and method activate. Specific styles also include all the
settings specific to their tool: for example, if you create a text style, it stores the current
settings of the Text tool, such as font, size, alignment, etc.

Architectural elements like walls, columns, doors and windows can have predefined sets of
information, graphic properties and specific element settings: these templates that apply to new

elements or to selected elements are called Building Element Types.
A building element type also stores information such as name, tag and description, optional graphic
properties which can be loaded from an existing basic style and the settings (geometry and
options) of the current element.

Use the Styles and Types pane of the Resource Manager to manage saved styles and types: in this
panel you can add styles to the project from the HighDesign Library or the User Library; this panel
also provides the commands to create, duplicate, edit and delete styles.
The styles loaded in the current project are accessible via the

.

Project styles can be quickly created and managed through the Project Styles panel: you can
browse and manage the graphic styles and element types of the project, create new ones and
remove styles from the project.
This panel marks selected objects or the current tool without a style as “No Style” on the top and
lists all available Graphic Styles and Building Element Types of the project below: the current style
is highlighted in this list.

The main commands of the panel are grouped as buttons in the bottom of the panel:
To create a new style push the “Add” button;
To remove the current style from the project push the “Minus” button;
To open the Styles and Types pane of the Resource Manager, push the corresponding button.
The Add icon on the right of the Graphic Style section title opens the New Graphic Style
window, whereas the Add icon on the right of the Building Element Type section title opens
the New Building Element Type window.

It is also possible to open a drop down menu by clicking the triangle on the right of the name of a
style to get some options of the current style.
The options of the drop down menu are:
Duplicate Style/Type
Edit Style/Type…
Revert to Original Style/Type
Select All Uses of “current style/type”
Remove from Project

The New Style and New Type windows display one or more panes arranged in different sections.
The first pane shows the Identity section, which holds the information specific to the selected class
of objects, and the Graphic Properties section to set the general properties that are also available
in the Properties Bar.
The additional panes of the window can change, depending on the selected class, and present the
settings sections specific to the current class of objects.

The New Style window can be a single pane window if the selected class of objects does not have
its Settings window: in this case the new graphic style is a
which stores just name and
general graphic properties (layer, stroke color, fill color, line type, markers, pen weight, shadow);
these properties are optional and it is possible for example to create a graphic style only with name,
layer and stroke color. A Basic Style is a general style and can apply to all graphic objects.

If the selected class of objects includes specific tool settings the New Style window is organized in
panes corresponding to the sections of the Settings window of the tool: this graphic style is a
and stores general graphic properties and all the settings and options belonging to
the current class.

In the Identity section of the New Style window it is possible to enter the style name and select the
location of the new style:
This project only: selecting this option the new style is saved only in the current project, not
on disk;
User library: this option saves the style as a file in the User Library folder on disk and in the
current project as well.
Once created the new style is added to the list of the Graphic Styles section of the Project Styles
panel of the current project. Select it to draw new objects with that style (these objects are called
occurrences of the selected style). If the style is a Specific Style, the corresponding tool and
method activate. For example, activating a Dimension style will automatically switch the current tool
to Dimensions.
To apply a style to one or more objects, select the objects and click the style name on the Project
Styles panel.

The New Type window displays more options in the Identity section with the fields to enter Type
Name, Tag and Description.
Also, the Graphic Properties section is optional and can be activated by clicking the switch near the
section title. When this section is active it is possible to load an existing basic style through the
Graphic Style menu and extract its graphic properties.

The panes of the New Type window display the settings sections specific of the current class of
architectural elements: wall, column, door or window.
New types are added to the list of the Building Element Types section of the Project Styles panel of
the current project and can also be saved in the User Library folder.

Only Project or User Library styles can be modified. As for all other resources, styles and types in
the HighDesign library cannot be modified, but only duplicated in the User library or project.
To change the settings of a style, such as its name, graphic properties or specific element settings,
select it on the Project Styles panel and choose “Edit Style” or “Edit Type” from the drop-down
menu and open the Edit Style or Edit Type window.
This window differs from the New Style/Type window in some details: it is not possible to select the
location of the style and all fields and options show the settings of the selected style.
All changes made to a style automatically update all occurrences of that style in the project. If an
occurrence of a style is modified, when selected it is marked as modified in the Project Styles
panel. It is not possible to update or create a Style or Type by selection.

When an instance object has been modified by changing one of its graphic properties or settings,
you can revert it to its original style by choosing “Revert to Original Style” from the drop-down menu
of the Project Styles panel.

In the Project Styles panel open the drop-down menu of the style or type and choose “Select All
Uses of [style/type name]”. All the instances of that style on the current sheet are selected.

Select the style or type on the Project Styles panel and click the “Remove from Project” button (–),
or choose “Delete Style/Type” from the drop-down menu.
If there are any occurrences of that style in the project, a dialog lets you choose the “No Style”
option or a new compatible style to replace the one you are removing. The objects whose style is
replaced are updated to match the new style.

General information about creating objects
Selecting and deselecting objects
Datum points and guides.
Drawing and editing line segments
Create polygonal shapes with mixed line and arc segments
Create closed rectangles and regular polygons
Closed regions filled with hatch, color or texture
Drawing circles and circular arcs, ellipses and elliptical arcs
Drawing bézier paths and splines.
Inserting images into the project
Group objects together into a single object
Create reusable components

The basic process of drawing any object in HighDesign consists of selecting the desired tool,
choosing a drawing method from those available in the tool and clicking on the drawing area to
start the construction of the object. If there are selected objects, the first click deselects everything.
New objects are created using the current default graphic attributes and properties: layer, stroke
and fill, line-type, etc. If the object being created is an element, that is, an object that is more
complex than a basic shape such as hatches or texts, you can set the specific defaults via its
Settings window. Double-click the tool icon on the toolbox to open the Settings window for that
class of objects.
Attributes and properties can also be changed at any time after the object has been created: select
the object and change the desired properties.

The default drawing procedure adopted in HighDesign is “Click-Move-Click,” i.e. to draw a line you
click to set the start point, move the pointer to the desired location and click again to set its end
point. Click-drag is also supported. You can change the drawing method in
.
To cancel an operation you can hit the “Esc” button on the keyboard, or press the right mouse
button.
Multi-segment objects, such as polylines, hatches, paths, follow the same general method: click to
define the vertices, double-click or press the Esc key to end.
The general drafting procedures described above are also valid for Drafting, Documentation and
Design tools.

The Arrow tool lets you select drawing objects by clicking directly on them or by defining a selection
area. To select an object, click on it with the arrow tool. Snap to Objects must be active so that the
arrow tool can “see” the object you are clicking.

Click on a blank part of the screen and move the pointer to define a rectangle: objects with control
points within the rectangle will be selected.
If you move top-to-down, the selection will include all partially or fully enclosed objects (inclusive

selection); if you move down-to-top, the selection will include only fully enclosed objects (exclusive
selection). You can invert the selection mode at any time by holding down the Alt (Option) key.

Use this method to select objects by defining a polygonal region. Click to add a vertex to the
selection region, double-click to end

Hold down the Shift key while clicking to add items to the selection or remove already selected
items. Click on a blank part of the screen to deselect all. If the option “Arrow tool clicks extend
selection” is active in Preferences, clicking an unselected object will automatically add it to the
selection.

When two or more items overlap it can be difficult to select the right object. To get a smart
selection, activate the Arrow tool, hold the Control key and click or right-click on the intersection to
open a contextual menu with a list of all the objects at that location, from top to bottom.

The Arrow tool can also be used as an all-purpose editing tool: most of the tool-specific editing
actions, such as resizing a line or editing a text, can also be performed with the Arrow tool.
Clicking a selected object on its outline, but not on a vertex, will activate the Move function.
Clicking a vertex of an object resizes the object.
Hovering the cursor on a vertex of a selected hatch, polyline or spline opens the menu with
the options to edit the vertex.
Hold down the Command key to move any object, selected or unselected, by any of its
vertices or by its outline.

The Construction Objects tool can be used to mark reference elements and auxiliary objects in the
drawing. It has three modes: point, to create reference points in the drawing; construction line, to
add infinite lines for alignments and margins; origin, to set the origin of the coordinate system in the
current drawing.

Click on the desired location to insert a point or press the X and Y keys on the keyboard to enter its
coordinates. In the Print window you can choose to print datum points and construction lines.

This method allows you to create guides, that is infinite lines that serve as references in the
drawing. Construction lines can be created with two methods:

When the rulers are visible in the main drawing area (
), click and drag on the
horizontal or vertical ruler to place an aligned guide. You can snap to drawing objects while
dragging to place the guide at the desired location. This method works with any drawing tool.

With this method you can create a construction line oriented at an arbitrary angle.
1. Activate the Construction Objects tool > Construction Lines method.
2. Click to set the center and define the direction with the pointer. You can enter a definite angle
by pressing the A key on the keyboard or clicking an existing linear object to draw a parallel
construction line. To set the distance of the construction line from the reference linear object,
press the L key on the keyboard, enter the value and click on the desired location.
You can create a guide parallel to an existing guide, like a duplicate: with the Construction Lines
method, click on an unselected construction line in the drawing and move. Use the keyboard to
enter a constrained distance.

Construction lines can be moved just like any other object: select the line, click anywhere on it and
move the pointer. To constrain the translation by a definite distance, enter the desired length
directly and press Return or Enter.

Click to change the origin of cartesian axes and rulers. The coordinates of the drawing and
dimensions are updated automatically. You can also change the Origin by using the button on the
intersection of the rulers. In HighDesign Professional each sheet has its own Origin.

Probably one of the most used tools, the Line tool allows you to trace straight lines of any length
and angle from a start point to an end point.

A line segment from one endpoint to the other.

Creates a line segment from its midpoint.

Creates a series of connected lines. Click to set the first vertex, then click to set the next vertex. To
end the series, double-click on the last vertex. Each segment is a separate line.

Creates two parallel segments of the same length at the specified offset. Activate the Offset field
next to the method icons to enter a value. Double lines can be traced from the axis or from one
side.
The standard method of drawing a line of given length is to set the first point, push the L key (or the
corresponding shortcut), enter the value and push the Return key. The same procedure applies to
Angle (A), X, Y. More methods are described in the Basic Tasks chapter.
To resize a line, select it and with the Line tool active click one endpoint. Click its midpoint to move.

The Poly-line tool creates a polygonal shape made of a connected series of straight and curved
segments. Curved segments are arcs drawn by center or by tangent.
To draw a poly-line, click to set the first vertex, then click to set the next vertex. To end the chain,
double-click on the last vertex.

While creating a poly-line, an action icon follows the start point of each segment. Click it or hover
on it to open the options menu and choose the type of the next segment, delete the last segment or
end the shape. To close the poly-line, select the corresponding option or place the last vertex on
the first one. Poly-lines have the fill option available in the Properties Bar.

A poly-line can be edited in several ways: activate the Poly-line tool and select the object (if it’s not
already selected); then:
click a vertex to stretch it
click a mid point to move the entire segment
click on a segment to add a vertex
place a vertex over another vertex to delete it
hover the cursor on a vertex to open the Edit menu
The Object info panel provides more editing options:
Drag the Convex slider to change the convexity of the current segment. This option can easily
convert a straight segment to an arc and vice-versa. The Radius value is automatically
updated when using the convexity control: you can also set the radius value numerically.
Use the Closed switch to close the polyline. The closing segment takes the same type as the
last segment added.

Use this tool to draw rectangles, squares and regular polygons of any number of sides.

To draw a rectangle, click to set the first vertex, move the pointer and click again to set opposite
vertex. You can add diagonals to a rectangle by pressing the Option key on the second click. To
draw a square, use the rectangle tool and hold the Shift key to constrain the diagonal direction.
To set the size of the rectangle, click to set the starting vertex, then push the “W” key to set the
width and “H” to set the height. Positive values go rightwards and upwards. To edit the rectangle
with either the Arrow tool or the Drawing tool active, click on vertices to resize, on midpoints of
sides to stretch, and click on sides or center point to move.

Click to place the first vertex, move the pointer and click again to set the base angle; then move the
pointer and click a third time to set the height of the shape. To set the dimensions, click the first
vertex, push the “A” key to set the angle, the “W” key for the width and the “H” key for the height.

Click to set the center of the rectangle; move and click to define the orientation and the first axis;
move and click again to define the perpendicular axis.

This method allows you to draw regular polygons with any number of sides starting from three. To
set the desired number of sides, use the offset field in the Methods bar next to the tool methods
and insert the value.
To draw a Regular Polygon by the external radius, click to set the center of the shape (all these
regular polygons are inscribed in a circle), move the pointer and click again to set the radius of the
circle circumscribed and the vertex of the polygon.

This method lets you draw the polygon by setting the center and the radius of the circle inscribed in
the polygon.

Creates a polygon defined by the side. To create the polygon, draw the first side, exactly like a line
of the desired length and angle, and click again to place the shape at the desired location.

Use the Hatch tool to fill polygonal regions with a color, a linear vector hatch, a tiled vector pattern
or a texture. This tool has four methods: Hatch region, Hatch at click, Polygonal Islands and
Circular Islands.
Hatches can be chosen from a list of types: HighDesign comes with a wide range of built-in hatches
that can be easily extended with your own hatches. You may also combine fills and hatches.
To set or edit hatch attributes, select Edit Settings Window Hatch Pattern or double-click the
corresponding icon in the Tools bar to open the Hatches & Fill Settings window.

The Settings window displays all options for the graphic properties specific to the tool and the
controls and fields for tool setup.
On the top bar of the dialog, close to the title, is available the triangular button to select and load
existing styles: on the right there is the Add icon which allows to create a new style by the current
settings. These general features of the title bar of the Settings window are shared by all drawing
tools with specific settings.

The

are:
Border: select to show the border of the hatched region and select its color.
Fill: select to add a solid color or gradient fill. Use the fill color button to select the color and
options.
The Hatch/Texture checkbox enables the vector hatching of the region; the color of the hatch
can be selected via the Pen Color menu on the Properties bar.
Scale Factor: use this slider to scale spacings and offsets of the hatch or to resize the tile of
the texture.
Draw at scale: adjusts the scale of the hatch to match the current sheet scale, so as to resize
the hatch accordingly. This option is especially useful when the hatch represents an actual
construction element like a floor or a wall.
Rotation: controls the rotation angle of all the patterns of the hatch. Textures can only rotate
by 90 degrees.
Hatches table: lists all installed hatch types, including any custom types.
The last cell of the Hatches table is a special button: click it to add hatch types to the current
project. This option opens the “Hatch patterns” pane of the Resource Manager window.

To draw a Hatch/ Fill region, use this tool in the same manner as the Poly-line tool or select
an existing polygon and choose

. While drawing a Hatch / Fill region, it

is possible to delete the last vertex with a click on the X icon close to it.
To edit a vertex of a hatch region, select the object and, with the Hatch tool active, move the
pointer over the vertex till the tool menu shows up with the edit options.
To add a vertex, click on one side or click on the “Add Vertex” option of the menu; to erase a
vertex, move the pointer over that vertex and click on the corresponding option of the tool
menu.
The “Fit arc at click” option shows up when the pointer is over the start point of an arc and
allows the user to edit the selected hatch and fit the arc with a click on it.
Hatches can also be inserted on homogeneous shapes with a click on their outline.
Hatches and Fills can host multiple openings of polygonal and circular shapes. These openings are
called islands and there are two different tool methods to create them.

To define a polygonal hatched region, click on each vertex of the region and double click to end.

It is possible to apply the current hatch to homogeneous shapes such as Poly-lines, Rectangles,
Polygons, Circles, Arcs, Ellipses, Free-hands, Curves with a click: just activate the method and
click on the outline of the shape you wish to hatch.
Regions enclosed by connected walls can be hatched with a click inside.

Select this method to create polygonal openings in existing hatches by drawing the shapes of the
islands within the selection. To do this, just activate the Hatches & Fills tool, select the method and
click on the vertices of the polygonal opening you wish to create within the hatch. This method can
be used on either selected and unselected hatches. The nearest hatch is detected automatically as
you move the cursor over the project.

This method allows you to open circular islands defined by center and radius. Click to set the
center and click again to set the radius: it is also possible to set the value of the radius numerically.

To edit the island, select the hatch and locate the pointer over one vertex of the opening till the tool
menu shows up giving you the options to remove the island, to delete one vertex or to add another
one.

Use this tool to draw circles, arcs, ellipses and arcs of ellipse. All the methods for circular arcs can
be used to draw full circles by clicking the switch that appears on the screen next to the first point of
the arc, or by holding down the Alt key.
The construction can be both graphical, via clicks on the drawing, or numerical via the keyboard
input.

To draw an arc or circle click to set the center (or set it with by coordinates), then select the arc or
circle option on the on screen floating button.

To draw an arc, set the radius by pressing the L key, set the start angle by pressing the A key and
set the end angle by pressing A again. To draw an arc graphically, move the pointer and click again
to set the start angle; with the next click you define the end angle of the arc.
To draw a full circle, set the length of the radius by pressing the L key on the keyboard and the start
angle / end angle by pressing the A key. Press Return to confirm.

Click to set the first vertex of the diameter, move the pointer and click again to set the second
vertex. You can define the diameter by pressing the L key, and the angle by pressing the A key.

Click to set the start point and end point of the arc and click to set the radius. The two points and
the radius can also be defined via numeric input using the X, Y and Dx, Dy coordinates and L
value. Hold the “alt” key to switch the direction of the arc.

Click to set the points that define the arc. The three points can also be defined via numeric input
using the X, Y coordinates or L and A values.

Click on the endpoint of a line or on the endpoint of an arc to set the first point of the arc drawn by
the tangent to that object at that datum endpoint.

Set the start point, move and define the end point of the diagonal. The ellipse is inscribed in the
rectangle defined by its diagonal.

Click to set the center of the ellipse, move and click to define its first radius; move again and click to
set its second radius. The center can also be defined by using the X, Y coordinates and the radii
can be defined by pressing the L key during their construction.

This method allows you to draw quarters of ellipse by clicking on its two vertices.

The Curves tool allows you to draw, single and multiple Bézier curves, Freehand lines, Spline
curves and clouds.

This method can be used to draw multiple, connected Bézier paths, parametric curves defined by
two vertices and two tangent lines:
Click to set the first vertex, move the pointer and click to set the next vertex; double click to
end the chain of Bezier curves.
To draw a curve during construction, click and drag to define its profile.
The resulting path now can now be edited to smooth the vertices and turn the straight segments
into the desired curves: this way the first tangent of the next curve is always defined by the
previous one. Bézier curves have the Fill property: select the desired color on the “Fill color” menu
of the Properties bar.
Hover the cursor over one vertex of the selected curve toshow the pop-up menu with the
options to add or delete vertices and smooth or sharpen the path by creating connected
curves or straight segments.
By clicking on one of the four control points of a selected curve, you can change its position
and visually adjust the profile. With multiple Bézier curves, by editing a definition point the
connected tangents are constrained to keep the same angle: move the control points of the
tangents to change the angle and adjust the shape of the curve.
Hold down the
key +

key while moving the control points of the tangents to edit asymmetrically;
key to disconnect the tangents.

The Freehand method lets you create spline curves by following the movement of the cursor. The
freehand method has two properties: smoothing factor, that defines the complexity of the curve,
and the drawing option. You can adjust the smoothing factor of new paths through the Freehand
settings window: 1 means that the path will preserve its original shape, but might have many
vertices; 6 is the maximum smoothing and the path will be considerably simplified.

In the same pane, you can also choose to draw freehand paths with a click-drag method instead of
the standard click-click: this option is specially useful when used with a pen tablet, because it
allows a more natural way of drawing with a pen.

Spline curves in HighDesign are cubic B-spline, continuous curves drawn through a given set of
points: to create a spline curve, click to set the points that define the shape of the curve. Double
click on the last point to end the curve. Choose the fill color from the corresponding menu of the
Properties bar.

Hover the cursor over one vertex of the selected curve to show the pop-up menu with the
options to add or delete points;
Move the given points of the selected curve with the Arrow tool or with the pointer and the
Spline or Freehand tool method active.

with this method you can create a group made of chains of connected arcs. You can use this tool to
draw a personal set of revision clouds to be saved as symbols for future uses.

The Symbols Tool is a drawing tool which allows you to put in your project entire drawings or
portions of drawings already created and stored in a library with just one click. Using Symbols is a

convenient way for reproducing many times the same group of elements with independent rotation,
mirroring and scale factors.
Symbols can store attributes, which are information displayed at the desired location of the current
view.
To edit or set the Symbol Tool properties, select Edit
the Symbol Tool icon in the Drawing Tools bar.

Settings Window

The Symbol settings dialog has two panes: Symbol and Attributes. The
with many options to choose a new symbol and set its graphic properties.

Symbol or double-click

provides you

The table lists the currently selected library folder: this folder may contain many sub folders
and can be organized at your choice. Browse through this table to select the symbol file.
Once a symbol has been selected, a lists all of its views shows up if available: select a view
from the list to activate it; double-click its name to change it and click on the pencil icon to edit
the symbol/ view (for custom symbols only).
The preview box displays a thumbnail of the selected symbol with the current parameters.
Symbol geometric parameters are: width, height (which can resize proportionally), angle (in
degrees); Below the input fields, the Quick transformations buttons enable the mirroring of the
symbol. Symbol properties are the fill and color options and the option to scale the symbol
correspondingly to the current drawing scale.
On the bottom are grouped the buttons to (from left to right) create a new folder, create a new
symbol from selected objects, duplicate the selected symbol, add a new view to an existing
symbol and delete the selected item.

The
displays the optional attributes of the current view. Use this pane to set the
values of the attributes of the symbol or symbol view you are inserting in the project or to change
the values of the current selection.

The “New Symbol” and the “Edit Symbol” functions, also available through the Project menu, when
activated switch to a different workspace with a limited set of tools: in this environment you can
draw, modify and save symbols and symbol views.
You can either create a new symbol from scratch or create a new symbol from the selection: in this
case you can also activate this function through the Radial Menu for a quicker workflow. This way
the selected objects are now visible in the “Edit Symbol” environment whereas all the other
elements of the drawing are hidden.

1. Select “New Symbol” on the Project menu;
2. The Environment turns to the “Edit Symbol” context with a limited set of tools and the “New
Symbol” dialog opens; this dialog is divided into four sections:
Symbol Name;
View;
Attributes;

Insertion Points;
1. Draw the symbol;
2. Type the symbol name;
3. Select the destination folder through the folder button;
4. Use the “+” button to add a new view;
5. Type the view name;
6. Set the attributes;
7. Insert the attributes in the drawing of the symbol view;
8. Place the Insertion Points on the desired locations of the symbol view;
9. Press the “Save” button on the dialog.

Attributes are information added to the current view of the symbol: these information are defined by
an ID, a Prompt, showing on screen, and a Default value which will be displayed in the project.
The Attributes section of the New Symbol dialog shows:
The menu of the existing attributes of the view (visible when editing a symbol and its
attributes);
The Add button to create a new attribute;
The button to remove the selected attributes,
The “Edit attribute” button to modify the currently selected attribute.
Since attributes are a sub-class of text, they can get text properties such as font, font size,
alignment, style and rotation angle: the “Define Attribute” window displays all these information and
options.
To insert the attribute, just click on the desired location of the symbol view.

To edit a symbol you can click on the Edit button of the selected symbol on the Settings window, or
select the symbol on the drawing and either choose “Edit Symbol” on the Project menu or use the
Radial Menu.
The “Edit Symbol” workspace opens and you can modify the symbol, add views to the symbol by
pushing the “+” button of the dialog or delete views through the “-” button, change the attributes of
the view.
By pushing the “Save” button, the environment turns back to “Drawing”. Changes made to a symbol
are immediately visible in all the symbol duplicates of the drawing.

Open the Symbol Library dialog by choosing Edit

Settings Window

Symbol or by double-

clicking the Symbol icon in the Drawing toolbar;
Select a symbol in the Folders table and choose one of the available views;
Set its size and optional parameters;
Review or change the default attributes if available;
Click one of the defined insertion points, the center or one of the vertices or midpoints of the
thumbnail to select the current insertion point;
Either drag the preview to the drawing or click on the desired point of the drawing.
To create a new symbol, to add a view to a symbol or to edit an existing symbol, are also available
the specific commands on the Project menu.

Images in HighDesign can be inserted via the Insert Image command, available on the File or
Project Insert menus. The supported file types are TIFF, JPG, PNG, GIF and PDF. Alpha levels
present in TIFF and PNG files are preserved. Once inserted into the project, the image is treated as
a vector object with coordinates, width, height and angle parameters.

HighDesign lets you easily add pictures to your project from several graphic formats (TIFF, JPEG,
PNG, GIF, BMP, PDF). Images inserted into the project keep their resolution and are displayed at
the real print size: it is possible to handle them as any other vector entity. PNG and TIFF images
are imported with their alpha channel if present.

File

Insert Image…

Project

Insert

Image…

Double click the Image tool icon to open the Settings pane, push the Open Image button and
the Open button on the pop-up panel.
Drag and drop an image file from the computer.
Drag and drop a picture from another application, such as a web browser or a photo archiving
software.
Paste a picture from the system clipboard.

The selected image is ready to be inserted: click anywhere on the project to insert it.
The Insert Image tool provides a popup window for the quick selection of images used in the
current project or recently loaded.
PDF documents can be inserted as high-resolution images. When you choose a PDF document
with the Insert Image command, you are presented with a dialog where in you can select the page
to import, if more than one, and set the resolution at which the image object will be created.
Images can be moved, resized and rotated, either via the editing tools, the Object Info panel, or the
Image Settings window.

The Image Settings window displays the following options to set size on screen, print size,
resolution and transparency of images:
Size: the dimensions of the image object in the project, measured in points, millimeters,
inches or percentage;
Image Resolution, in Dots Per Inch.
Display at screen resolution: when active, the image is always displayed at the resolution of
the screen, which is typically lower than paper. The visible size of the image is larger at lower
resolutions.
“Restore Original Values” button, to reset image size and resolution as in the source image
Transparency: sets the amount of transparency the image is displayed at. Values range from
0%, totally opaque, to 100%, totally transparent.

File Format: images are handled like other vector objects and saved in the project file. The
internal format can either be PNG, which preserves the full quality of the image, or JPEG,
which compresses the image and saves file size considerably, but reduces the quality. JPG is
very good for photographic images, but not for images that contain line drawings, such as city
maps or scanned drawings.

Image Size and Resolution fields allow numerical changes. Please note that the Size/Resolution
ratio is constant and therefore, when changing the size, the resolution will change accordingly and
vice versa.
Use the “Info” button close to the Image Preview to show the information of the source image on its
preview canvas. Provided information are: file size, creation and modification dates, location of the
file, image dimensions expressed in pixels and its resolution.
When the pointer hovers over the Image Preview the “Replace Image” button appears: click on it to
select a new source image to insert within the existing image box.

HighDesign provides the ability of grouping different objects together as a single item. Most editing
operations and transformations can only be applied to selected items, either to individual objects or
to a group of objects at once.

Groups are a convenient way of organizing items by binding heterogeneous items in one
“collection” which behaves as one object. Once a number of drawing objects are grouped together
you can select them simply by clicking any of the group members. By default, the grouped objects
retain their attributes, such as color, line type, weight, etc. Changing the attributes of a group
applies the changes to all its members.

All commands connected with groups area available in the Project menu. The functions to manage
groups are Group, Ungroup, Automatic Grouping, Ungroup All, Edit Group.
“Group” creates a new group with all the currently selected items;
“Ungroup” breaks the selected groups;
“Add to Group” includes selected objects in the currently selected group;
“Automatic Grouping” is an option that automatically creates groups with items of a shape, i.e.
rectangles, regular polygons, poly-lines, walls, etc.;
“Ungroup All” breaks all groups, including those not selected.
“Edit Group” opens a workspace where you can modify the selected group by editing, adding
or removing members by using the normal drawing tools.

Grouped objects can be edited all together like a single drawing object by stretching the handles of
the bounding box of the group with the Arrow tool. A group can be moved, rotated, mirrored or
scaled like any other object.
A group can be resized and moved with the Arrow tool. Properties applied to a group are
applied to all the group members.
To select individual members of a group, hold down the command key and click the object.
The object will be selected and available to to be modified or deleted. This method is more
suitable for quick editing operations.
You can also modify the members of a group through the Edit Group command.

You can activate the Edit Group workspace by selecting a group and clicking the Edit icon on the
top-left handle point or by choosing
This workspace opens a panel with
specific commands that let you manage sub-groups, show or hide the context, add objects to the
group or remove objects from it.

If the group includes sub-groups, you can use the Sub-Groups menu to activate any sub-group or
return to the main group. To edit a sub-group, click the Edit icon above its top-left corner. Click
“Done” to end the edit.
By default, the edited group is displayed within its context, that is, the surrounding objects of the
drawing it is inserted into. You can adjust the level of opacity of the context or disable it altogether.
To add an existing object to the group, push the Add Object button in the Actions section and click
any object in the context. In likewise manner, push the Remove Object and click on any object of
the group to remove it from the group. The removed object will be moved to the sheet where its
original group resides.
You can also draw any class of object using the tools that are available on the Toolbox. Any object
created in this way will be added to the current group.
Push Done to confirm the changes and return to the normal workspace, or push Cancel to dismiss
all the changes made in the Edit Group workspace.

Construct basic and compound walls with automatic connections
Insert columns and pillars
Add windows.
Insert doors of diverse families

The Wall tool allows the creation of walls which are parametric objects, automatically connected on
their vertices and borders. To set the attributes, double-click the Wall Tool icon or select
to open the Wall Settings dialog.
Walls are classified into two families: Standard-case Wall, made of one, uniform component, and
Compound Wall, made of different components.

Standard-case walls have one uniform component and its representation can be a solid color fill, a
hatch, or a combination of the two. The geometry can be rectangular, with a constant thickness
from start to end point, or polygonal, with variable thickness from start to end.

Basic walls automatically join to other basic walls, regardless of thickness and fill, unless the joints
are disabled in the Settings window.

Type pop-up window and New Type icon.
Family, Basic or Compound
Geometry and Thickness, in the current unit: selecting the option of variable thickness
enables the end thickness field.
Leading side and Exterior side: select the construction side of the wall. You can also access
this option by clicking the pop-up menu icon during the construction the wall. The option to
invert the interior and exterior faces of the wall allows to switch the sides of the wall. The
exterior side is highlighted in blue when drawing and selecting walls. Wall Joints options.
Deselect an option to disable the automatic connection of new walls or to unlink an existing
wall.
Border attributes: Line type and pen weight.
Fill attributes: solid color, hatch type and color, hatch scale.

Compound walls consist of multiple layered components, each with its own properties. Compound
walls can only be rectangular in shape, with constant thickness from start to end. The total
thickness is calculated as the sum of all the internal components.

Compound walls can have any number of internal components, and you can add, remove,
reorder and edit the components at any time through the Components window.

By default, basic walls and compound walls do not join automatically, because they are
different elements that would not be joined in a real situation. Also, they are made of different
materials which would not match. However, if a particular situation requires it, you can choose
to activate the Allow Joints options and attempt to join two walls of different type.
Compound walls can use one pen weight for both borders and internal divisions, or you can
assign a pen weight for the outer borders, and one for the internal components.

Type pop-up window and New Type icon. This window lists all the available Types, of both
basic and compound families. It is advisable to enter descriptive names when saving a new
wall type.
Wall Family.
Components section:
Edit Components button to access the Components window; use this button set the
components of a new wall or edit an existing wall.
Total computed thickness; the sum of thickness of the internal components determines the
total thickness of the wall.
Internal pen weight of components. The pen weight can be Same As Borders to set the same
pen weight as that used for the borders of the wall, or one of the available pen weights.
Leading Side: see Basic Wall Properties Window for the description.
Wall Joints options: see Basic Wall Properties Window for the description.
Border line type and pen weight. Internal components can only have a continuous line
division.

Use this window to set and edit the components of a compound wall.
The table lists the components of the wall from the exterior side to the interior, with a progressive
index number. The selected component is highlighted in the preview, which shows the current wall
at the scale set in the lower left corner. You can check how the wall is rendered at the different
drawing scales by using the drawing scale menu.

The total thickness of the wall is computed on the sum of the single components and shown at the
bottom of the Thickness column.
You can add, remove and reorder the components, and rename a component by double- clicking its
name. Use the + button to add a new component and the – button to remove the selected
component in the table. Adding a new component opens immediately the properties editor. To edit
a component, click the Edit icon on the right.

Function: each component has its own function which can define its behavior and
appearance. The available functions are: Exterior and Interior Finish, Thermal Film, two kinds
of Thermal Insulation, Air Layer, Substrate, Structural, Membrane. There can only be one
exterior and one interior finish. The (batting) Thermal insulation component is always
rendered with the Insulation line type.
Thickness, in the current drawing units;

Fill color, hatch, hatch color and hatch scale.
Click the Cancel or OK buttons to cancel or confirm the changes to a component and return to
the list of components. The button confirms the current component and creates a new one.

To draw a wall, click to set its start point, move the cursor and click again to set its endpoint: walls
are connected like poly-lines. Walls have their construction side and the “Exterior side” property,
marked with a blue line, to consider when inserting openings: to change the leading side while
drawing, click on the Option menu close to the last vertex. Press the Alt key to invert the exterior
side while moving the cursor.

A compound wall can be inserted by its structural component: choose between exterior, interior
sides and middle line to easily align your walls to the structural grid.
To edit a wall, select it and move, stretch, shorten it with the Arrow tool or change its parameters
numerically via the Object Info panel.

The
section of the Object Info panel enables the changes of the coordinates of the three
control points of the selected wall: use the arrows to select the active point and the fields to enter
the new coordinates.
The

section displays the following options:
Length and Width fields to change its geometry;
Leading side buttons to change the construction axis of the wall (this option can shift the
selected wall accordingly);
Invert Sides to invert Interior/Exterior side of the wall (this can invert the opening direction of
windows and doors inserted in the selected wall).

The
section shows the wall Name, Tag and Description fields to add information to the selected
wall and provides the Settings button to open the Wall Settings window.
The Tools menu and the contextual menu provide two commands specific for walls: Convert to Wall
and Rebuild Wall.

Convert To Wall applies to lines, polygons, arcs and curves. This function converts those objects
into walls with the current settings: select the items to convert and then choose
on the Tools menu. This command is also available as a button in the Edit Tool
Bar.

Use this command to regenerate the geometry, side intersections and nodes of one or more walls.
This is especially useful in situations in which a node needs to fixed.
The Rebuild Wall tool can either be applied to selected walls, or to multiple walls in one run by
clicking on them.

1. Select the walls you want to rebuild;
2. Choose Tools

Rebuild Wall or open the radial menu and choose Rebuild Wall from

the Tools submenu.

1. Choose Tools

Rebuild Wall or open the radial menu and choose Rebuild Wall from the Tools

submenu.
2. Click once on each wall to rebuild
3. Click on a void part or on another object to end.

The Columns tool is used to design square, rectangular or circular pillars.

To use the Columns and Pillars tool, double click the tool icon and open the Settings window to
choose the family of pillar. The Settings window displays on the top bar the option to open the popup window and select existing Types: it is also possible to save the current settings as a new
Column Type.

Set the base and click once to place the square pillar. As pillars can have any base angle, you have
to click again to set the desired angle.
When the Rectangular pillars option is active, the input fields for width and height are both
enabled.
Round columns require just to enter the diameter and one click for insertion.
The Column tool also features automatic alignment and distances. When inserting or editing a
column, it automatically aligns to the structural grid of the previously inserted columns. You can
also enter the dimension and automatically snap all the new columns to that predefined value.

Use the
points.

section to change the position of the column by editing the coordinates of its control

The
section shows the Width, Height and Angle fields to change size and direction of
the selected pillar or the diameter of the selected round column.
The

section enables the addition of information (name, tag and description) to the selection.

The Windows tool allows you to design parametric openings to insert within existing walls. Even
though windows are complete objects, they always refer to a wall and cannot be inserted outside a
wall; furthermore, windows refer to the exterior side of the wall.

To edit and set properties and parameters of windows, select
to open the Window Settings dialog. This dialog provides all the options to customize
the opening by choosing the opening family and all the parameters that can be stored as Window
Types. The Settings dialog is structured as a two panes window: Geometry and Options.

Type pop-up and New Type icon: load a saved type or save a new type with the current
settings;
Family menu: click to choose the kind of opening. Available options are:
Empty Opening
Generic Window
Simple Window
Casement Window
Single/Double-Hung WindowSliding Window

Widths:
Rough Width is the full extent of the opening in the structure of the wall, including the casing;
Nominal Width is the span between the jambs;
Reveal: select the shape of either side surface of the window, including jambs;
Reveal Preview and settings fields: enter the desired dimensions;
Offset from exterior surface of the wall: enter the value in the current units;
Insertion Point: click to select the insertion point of the window (start, middle, end).

Frame Dimensions: Preview and setting fields to enter the frame dimensions;
Open Direction: select to flip the opening side (inside/outside);
Show Sill option and input fields to set the offsets of interior and exterior sides and their
dimensions;
Show Casing options (Outside and/or Outside), Trim Width and Trim Thickness fields;
Partitions: set the number of the vertical partitions of the window.

To insert a window in a wall, activate the Window tool in the Tools bar and do as following:
1. In the Settings window load the Type if available or select the family of the opening;
2. Enter the desired window settings;
3. In the Project window set the position of the opening by clicking on the wall;
4. Click the internal / external area of the wall to choose the opening direction.
As you move the cursor over a wall, temporary dimensions show the relative distances of the
opening from the surrounding vertices or joints of the wall.

To set and constrain the value of either dimension, so that the opening is exactly at that distance
from a reference point, enter the value on the keyboard and move the pointer, so as to choose
which dimension on either side of the wall the value applies to. Click to confirm and insert the
opening.
Windows are always inserted relative to the external surface of the wall, which is marked in
blue when selected.

Click one of the control points of the selected window and drag to resize or move it within the wall.
If you drag the window by its center point you can enter the distance of the shift from the original
center: the window will result shifted by the selected direction and distance within the wall.
If you drag the window by its vertices it will result resized by the new length value and according to
the the direction of the shift.

The
section displays the Rough Width and Nominal Width fields to change the size of
the selected window.
The
section shows the Name, Tag and Description fields to edit or add information to the
selected window: use the Settings button to open the Window Settings dialog.
The Opening Direction of a window can be changed through the Settings window: select the
window, open the Options pane of Settings and select Opening Direction > “Open Inside” or “Open
Outside”.

As it is for windows, doors are parametric objects created through the Door design tool: these
objects can be inserted within existing walls only and, for some of their parameters, doors depend
on the walls they refer to.

To open the properties and parameters setup window of doors, select
: load the existing Door Type if available or customize the door by selecting its family and
setting all the parameters and options. Current settings can be saved as new types by pushing the
Add icon.
The Door Settings dialog shows up with two panes:

and

.

The Geometry pane offers the same choices of the windows Settings dialog. The Family menu
displays a wide range of available door configurations:
Empty Opening;
Simple Door / Double Simple Door;
Swinging Door / Double Swinging Door;
Bypass Sliding Door;
Surface Sliding Door / Double Surface Sliding Door;
Pocket Door / Double Pocket Door;
Folding Door / Double Folding Door.

Frame Dimensions: Preview and setting fields to enter the frame dimensions;
Open Direction: select to flip the opening direction (inside/outside);
Panel Type: option to represent the panels of the door as glass panels;
Show Sill option and input fields to set the offsets of interior and exterior sides and their
dimensions;
Show Casing options (Outside and/or Outside), Trim Width and Trim Thickness fields;
Options to invert the swinging side and to draw the axis line;
Swing angle slider;
Wall Projection options: click to project one, both or none wall edges.

To insert a door in the project follow the steps below:

1. In the Settings window load the Type if available or select the family of the opening;
2. Enter the desired door settings;
3. In the Project window set the position of the opening by clicking on the wall;
4. Click the internal / external area of the wall to choose the opening direction;
5. For single doors (swinging, sliding, pocket or folding doors) click on the wall to position the
door, then click in the desired quarter of the region described by the cartesian axes to set its
opening or swinging side. As you move the cursor over a wall, temporary dimensions show
the relative distances of the door from the surrounding vertices or joints of the wall. As for
windows, to set and constrain the value of either dimension, so that the opening is exactly at
that distance from a reference point, enter the value on the keyboard and move the pointer,
so as to choose which dimension on either side of the wall the value applies to. Click to
confirm and insert the opening.

Drag the selected door by its vertices to resize it or by its center point to move it within the wall.

The
section displays the Rough Width and Nominal Width fields to change the size of
the selected door.
The
section shows the Name, Tag and Description fields to edit or add information to the
selected door: use the Settings button to open the Door Settings window for specific editing
options.

Creating text blocks and single-line labels.
Adding text notes with arrows and element tags.
Measuring objects with linear, angular, radial and altimetric dimensions.
Highlight an area of a drawing

This tool lets you insert multiline texts, and labels into your project. A text block has its own
properties of font face, size, style, color, alignment and a background shape.
To set the properties of new texts, double-click the Text tool icon to open the Text Settings window
or choose the menu item Edit Settings Window Text…
To change the properties of an existing text block, select the text object and double-click the Text
tool icon or choose Edit Settings Window Text…
The Text Settings window provides easy access to all the graphic attributes of a text. If no text
object is selected in the drawing, it shows the default values that are applied to all new objects; if
one or more text objects are selected in the drawing, it shows the properties of the last text block in
the selection.
In HighDesign Pro values and current graphic settings can be saved as styles.

While every other object is represented at the current scale, texts and labels are always at 1:1 real
scale. Text paragraphs can be styled both as a block, with one style for all the text, and as a styled
text with multiple styles and colors. Rotated labels can only have one text style applied to all the
elements.

Font face, selectable from the list of font families installed in your system. You can also
access the Font Panel to select a different typeface (only supported for the entire text object).
Text size, in any supported measurement unit; open the pop-down menu to select a different
unit.
Text style (bold, italic and underline) of the entire text;
Alignment (left, centered, right; top, middle, bottom), in both multiline texts and single line
labels; Character spacing and Line spacing controls;
Writing direction options for international characters and languages.
Border shapes: plain paragraph (no border), rectangle, diamond, hexagon, circle or oval;
Border Color.
Padding: defines the space around the element’s content, inside its border.
Auto-fit box options: fixed size, flexible height, fit-text. When flexible height is active, the
height of the box adjusts to the number of lines of text.
To set the color of the entire text box, use the colors menu on the Properties Bar.

This is the method used to create text paragraphs with text styles. Click to set the base point, drag
the pointer to set the width and height of the text field, exactly as drawing a rectangle, and insert
the text in the input box; this box also supports the “Cut, Copy, Paste and Select All” commands.

When you define the text insertion box, the Text Styles bar opens allowing you to set the text
styles within the paragraph: this way you can have a text box with words of different font, size,
color and style. It is also available a pop-up menu for the insertion of special characters.
To confirm the text and end the insertion, click outside the text box field or push the OK button
on the Text Style toolbar.
Colors of the characters are displayed as defined by the parent block unless this is set to
“none”. Setting a specific color for the selected characters overrides the block color.
To cancel the insertion, push the Esc key or the Cancel button the Text Style toolbar.

This method allows you to insert text labels and paragraphs with given angles. Differently from the
Text Box method, texts created with this method can have a single text style.
To create a rotated label, once the text is entered in the field, you can set the base angle by
moving the pointer to rotate the label around the insertion point: click to end or set the given
angle numerically. To create the label without setting the angle, push Command + Return.
To edit the content of a text object, activate the Text tool, select the object and click within the
field: then modify the text; you can also edit the text by double-clicking the object with the
Arrow tool.
To resize a text block, activate the Text tool, select the field and drag one of its angles. Text
blocks only support resizing of width, not height, as the height of the object is calculated on its
width and its contents and style properties.

Use this tool to add text notes with leader lines and arrowheads and tags. The text can be multiline
and rotated, but only have one style of font, size and color.

Leaders can be linear, circular, curved, or invisible. The construction process is similar for all types
of leader: the first click defines the start arrow of the annotation and the second click sets the
endpoint and the angle; the movement of the pointer and the next click define the landing. Enter the
text in the input field.
A text annotation can have multiple leader lines. Use the corresponding methods to add or
remove a leader line from a text note.

Leaders can be added starting from the annotation going to the arrow point, or in the reverse
direction, from the arrow point to the annotation. To add a leader:
Activate the Add Leader method, click the unselected annotation and define the arrow point.
The new leader is constructed from the node point.
Alternatively:
Activate the Add Leader method, define the arrow point anywhere on the drawing and click
the annotation.

To remove a leader from an annotation, activate the Remove Leader method and click the leader
line to remove.
It is possible to remove all the leaders of an annotation, leaving only the text note.
In HighDesign SE/Pro, annotations can be associative so that their position is determined by
the parent element. Moving the parent element also moves the associated annotations.
When used on a project element, the annotation prompts basic information about that
element. Supported object classes are hatches, symbols, walls, columns, doors and windows.
For example, annotations added to symbols by default prompt a caption with the names of
the symbol and the current view.

. Tags are special annotations that automatically display selected
information associated with certain classes of elements:
Hatches
Symbols
Images
Architectural elements (Walls, Columns, Windows, Doors).

The Contents menu of the Settings window lists all the information that can be displayed in the tag
label: select the options you wish to display.

The information can be computed or extracted from those added to the corresponding class of
elements in the Object Info panel or in the Style/Type Settings window. Only the available
information are displayed in the tag label.

Text font, size and style
Horizontal alignment. Text notes are always aligned to the vertical middle.
Associative behavior (Standard/Pro). Switch on to associate the note to the clicked element.
Allowed elements are closed shapes (rectangles, polygons, hatches, ovals) and design
elements (walls, columns, doors, windows). Tags always have the associative behavior.

Contents pop up window (visible with Tags only). Through this window you can select the type
of information displayed on the tag:
Name
Size
Style tag
Instance tag
Description
Leader style: none; lines; curve; arc.
Label rotation.
Frame Styles and size. The size of the frame can be calculated automatically based on the
content of the text note, or set to fixed dimensions. When applied to architectural elements
the frame style of Tags is automatic and varies with the class of the element. It can be
changed afterwards through the Settings panel.
Frame padding defines the distance between the text and the frame.
Frame border color.

Use the Dimensions Tool to insert linear, multiple linear, radial, angular, ordinate and elevation
dimensions. To set the dimension properties, either double-click the Dimensions tool in the Drawing
Tools bar or choose
to open the Dimension Settings dialog.

This dialog is arranged in two panes: the Text and Graphics panes offer the fields, menus and
options to setup the tool with the desired properties and configurations.
In addition to custom units, dimensions can use a custom precision setting different from that
defined for the project.

Label font, size and style;
Dimension units;
Precision menu;
Behavior: associative status;
Label options: prefix; custom text to use in place of the measure; display units after the
measure;
Tolerances, upper and lower, and text size of tolerances, relative to the main label.

Arrowheads – open the pop-up to select shape and size of arrowheads;
Arrow size in the current units
Extension lines, long or short
Arrow gap, i.e. how much the extension line extends beyond the arrow, and extension gap,
between the extension line and the source point.
Label options:
position (middle, inside, outside, locked above and to the left of the witness line);
offset from the witness line;
Label frame option;
Orientation of label, horizontal or aligned to the witness line;
Option to flip the text relative to the direction of the source points.
In HighDesign Pro values and current graphic settings of Text and Graphics pane can be saved as
styles.

This method is used to insert linear dimensions between two points. The dimension line can have a
generic angle or can be axis aligned and display the dx or dy distance with absolute values. To use
this tool, click on the datum points and move the pointer to place the dimension line; if you move
vertically or horizontally (following the guide lines that appear on screen) you create a vertical or
horizontal dimension; otherwise, the dimension will be object-aligned.

Linear dimensions can be independent or associative. Independent dimensions are defined by the
source points as described above. Modifying the measured object does not affect the geometry and
value of the dimension. Associative dimensions are linked to their source element and update their
geometry and value automatically as the source object is moved or modified. Dimension and object
can reside on different layers.

All the default properties and settings apply to associative dimensions in the same way as
independent dimensions.

1. Activate the Associative option, either in the Settings window or by clicking the Associative
Dimensions button on the Properties toolbar, next to the Dimension methods.
2. Click the source object. Associative dimensions must be defined by clicking between two
vertex points since they require only the definition of the source object.
3. Define the height of the witness line, i.e. its distance from the source object.
Associative dimensions are marked with squares on the source points. These squares are only
visible on screen and are not printed nor exported.

An independent dimension can be changed into an associative dimension, and vice-versa. To
change the behavior of a dimension, select it and use the Behavior checkbox on the Dimension
Settings.

When an independent becomes associative, it lacks the link to an actual source object. Also,
deleting or otherwise removing the source object can cause the relative dimension to lose its link.
When an associative dimension does not have its source object, or is not able to find it, the square
marks are no longer visible and a yellow “caution” triangle appears near the mid point of the
witness line. An unlinked dimension can be re-associated to its source object or a new element in
two ways:
1. Using the command

. Either select the

dimension to link and begin the command, or begin the command and the click on the
dimensions. With this method, it is possible to associate more dimensions in one run of the
command. When you click on the dimension, a line is drawn from the mid point of the
dimension to the cursor. Click on the new source object or element to link the dimension.
2. Using the caution triangle. Click the yellow triangle of an unlinked dimension to begin the
Associate Dimension command. The procedure is then the same as above.

This method allows you to insert horizontal or vertical aligned dimensions (dx or dy distances) of
two or more progressive points. Once the first segment is defined, all following dimensions will
respect the first alignment and height.
Multiple dimensions support a “Continue” option: clicking an existing dimension allows to continue
the sequence using that dimension as base item.

With this method you can get radial dimensions of arcs and circles.
To create a radial dimension click on a circle / arc and move the pointer inside or outside the circle
to place the dimension; click again to set the end point. A dialog will show you the available options
of the information displayed in the label (radius, diameter, angle and length).

This tool lets you dimension the angle between two lines: to dimension an angle, click on the first
and on the second line; move the pointer to set the radius and the label position and click. If you
click outside the datum lines the dimension will show the complementary angle.

With this method you can calculate the perpendicular distance from an origin point. The origin is
identified with the Absolute Origin of axes. Distances along the x- and y-axes to objects to measure
are specified using extension lines, with the distances indicated numerically at their ends with text
labels.

Set the Origin and click on the points to measure: move the pointer parallel to the X axis to get the
Y distance and parallel to the Y to get the X distance. If you change the origin, Ordinate dimensions
will be updated automatically.

This method can be used to add elevation dimensions to your project.
To create elevation dimensions, set the “zero” datum, that is the Absolute Origin, and click on the
points you need to measure. All dimensions will display values relative to the origin; if you move the
origin, all other dimensions will change their values accordingly.

Dimensions can be edited to change their position, distance from the measured object and
placement of the label. With the Dimension Tool active, click one of the extension points and move
the pointer to modify the dimension; if the witness line is horizontal or vertical, the movement will be
direction-constrained.
Click on of the endpoints of the witness line and move the pointer to change its distance from the
extension points.
Click on the control point of the label to edit its placement along the witness line; you can also place
the label outside the dimension: in this case a line will extend from the witness line to the label.
are always associative: edit the measured object to change its position and
values; click one of the vertices of the extension line to change its position and place the label
inside or outside the circle.

can be edited to modify the radius and the width of the arc and the label
position: click on the arc and move the pointer to edit the radius.
, that are linked with the origin, can be edited by moving the control points
with both the Arrow tool and the Dimensions tool.
can be moved with the Move tool: the measure will be automatically
updated with the new position.

HighDesign Se and Pro include the Detail Area tool, a special tool designed to define rectangular
areas of the current drafting sheet to be printed or to generate details of a larger project (Pro).
These regions of the drawing can be printed alone, like portions of a larger project. Detail areas can
have a name, a color and a layer, and they are saved within the project like any other object.
If a Detail Area is linked to a detail of the project it is called Callout (Pro).

When the Detail Area is linked to a detail sheet, the Callout options of the Settings window are
enabled allowing you to specify the Head’s shape of the Callout (Round, Hexagonal, Oval,
Rectangular) and to customize the Text:
Font menu;
Button to open the Fonts panel of the System;
Button to select and load existing Text Styles;
Text size menu;
Text Default Styles (Bold, Italic, Underline).

To create a detail area, click and move the pointer to draw a rectangle; click to set the area and
insert a name in the input dialog. The detail area is displayed with a dashed and dotted border as a
default: the name of the detail area is displayed as a label in the top left corner of the area.

If the area is selected, a triangular button close to the label of the area shows up: click on it to open
the menu with the options to rename the area or create a new detail from the area.
When a new detail is created and linked to the area, we have a Callout. A Callout is displayed as a
detail area with a head, a marker showing the Detail ID on the top side and the number of the
Layout on the bottom if that detail is displayed as a viewport on a layout.
You can decide to hide detail areas during a normal design session by choosing the menu item
. The same command can also be used to show hidden detail areas.
To edit an area, select it and, with the Detail Area tool active, click one of its vertices and
move the pointer. To change the name of an area, select it and click on its name label; then
insert the new name in the input dialog.
To change the position of a Callout head, select it and move the marker along the border of
the area by the definition point of its leader.
Once you have created a detail area, you can open the Print window and select it from the
Print Area pop-up menu as a printable portion of the project.

Present your drawings in layouts.
Display firm, project, sheet and drawing information on layouts.
Creating views of your drawings for layouts.
Exporting your project as a PDF book.

Use layout sheets to display and arrange scaled views of your project on a standard-size sheet.
Layouts can show a pre-made title block with global information about your firm and the current
project and sheet-specific information.

These named pages are intended for publishing and output purposes, therefore layouts have some
characteristics that are unique and specific to this environment:
Layouts are opaque sheets
The scale of the layout is always 1:1 real scale
Layouts have a paper size, defined as default by the Paper Format settings of the project
You can choose to show the current print margins;Layouts always have a sheet ID
You can add a Title Block by choosing from the existing ones or you can create a new one
There are the options to show the frame border and the centering marks
You can set the nominal scale of the views
You can enter text information to the current layout to be shown on the title block
You can create one or more viewports to show and arrange selected views of the project at
the desired scale
The available set of drawing tools is limited to sketching and documentation tools

As for the other sheets of the project, use the Project Browser panel to create and access the
Layouts. The Object Info panel shows all the options, settings and information of the current layout
and is divided into four sections:
Sheet, which displays name and generic sheet information like scale and units;
Paper Size, to change the size of the current Layout only;
Layout Settings, to set sheet ID, title block and nominal View Scale;
Layout Info, to set the issue date and enter text information.

A title block is an element of a layout that contains information about the design firm, the client and
site location, the project and the sheet. It usually has a border and is organized in sections with
different types of data and is usually found on the bottom or lower right-hand corner of any layout
sheet.
A title block is a sub-class of the Symbol and inherits all the properties of symbols. The information
displayed on a title block can be entered as attributes that are defined when the title block is
designed. In addition to attributes, title blocks can contain text labels and blocks with custom or
automatic content.

You can create a new Title Block through the Title Block menu on the Object Info panel of the
current Layout or through the menu
. Title blocks are designed in a specific
workspace that provides the graphic tools required to draw the title block and a panel to set the title
block name and manage the text attributes.

1. On a layout sheet, choose Project

Title Block

New Title Block.

2. The first dialog asks you to choose a reference paper size for the new title block. Although a
smaller title block can be used on larger paper sizes, it is best to select the ideal paper size
this title block is intended for.

3. The title block panel lets you enter a name and the text attributes. Attributes can be of two
types: constant and custom.
4. To design the title block and its sections, use the drawing tools available on the Toolbox.

Attributes are text values with dynamic content. The pre-defined attributes can be selected through
the menu on the Title Block panel. These attributes are separate as:
Layout attributes which correspond to the information entered in the Layout Settings and Info
sections of the Object Info panel of the current Layout;

Project attributes corresponding to the information entered in the Project Information panel of
the Project Settings window.
Attributes of the title block can also be custom attributes and once you click the Add button, the
Define Attribute window opens displaying the options and input fields.

To insert an attribute on the title block, click on the desired location. Attributes are special text
objects and can be moved or aligned. You can modify the text properties through the Text settings
panel (double-click the Text tool on the toolbox to open it). To change its Attribute properties, press
the Edit Attribute button of the Title Block panel.
The Save button creates a new Title Block on the User Library which is immediately available for
use in the current layout and in new projects.
A Title Block can be inserted even in a layout of different size from the one it was created for,
depending on its bounds. When you select a title block it is automatically inserted at its default
position on the layout as a preset: anyway, you can move it to any other position as a drawing
object.

Viewports are elements that display scaled views of the project. Think of them as windows that
show a portion or the entire view of a drafting or detail sheet, and provide basic information about
the views. When you use layouts and viewports, the drafting sheets and the other design sheets
contain your project, whereas layouts and viewports show a clean view of the project suitable for
presentation and revision.

It is also possible to use only the drafting sheets to present your project, since drafting sheets
can have their own drawing scale and paper size. This workflow offers of the advantage of
directness because what you see on the drafting sheet is exactly what you will see on the
printed sheet, but it lacks the flexibility and scalability of layouts and viewports.
Viewports exist only on layout sheet. On each layout you can place one or more viewports that
reference different drafting sheets, parts of the same sheet or event the same view at different
scales. The view displayed in a viewport can use a custom rotation angle, a filter that changes the
way borders and fills are represented and a transparent color overlay.

To create a new Viewport use the button on the top-left corner of the Layout canvas or select the
menu command
. Viewports exist within Layouts only.
The Viewport tool lets you create a viewport directly by a detail area too: select the source sheet
and then choose a detail area. Position and size of the viewport will be taken from the source area
and updated live if the detail area is modified.
Alternatively, viewports can be created directly from a detail area. On a drafting sheet, select or
create a detail area around the part of the drawing that you want to show in the viewport. Click the
pop-up arrow near the detail area name, go to New Viewport by Selected Area and choose the
layout on which to create the viewport.

The Viewport dialog shows two panes with the Drawing and Title Mark options. The Drawing pane
provides the options of viewport window and selected view:
Source drawing (drafting sheets, detail areas or details of the project);
Scale of the view, which can be different from the original scale of the selected sheet;
Angle of the view, by moving the angular slider or by entering the value in the field;
Size of the Viewport – automatic, by the extents of the source drawing, or custom, by drawing
the rectangle of the viewport;
Filter applied to the view (by project, by layer, black and white, grayscale, etc.).

On the
you can set the position of the title mark within the viewport, the name of
the view, the option to show scale and other graphic options.
The available options are:
Show/Hide Title Mark;
Position of Title Mark within the viewport on the upper or bottom edge;
Title of the Viewport;
Font options – font menu, button to open the Fonts window, button to select existing styles,
font size and units menu, default text styles;
Show/Hide Scale of the view;
Show/Hide Extension Lines of the Title Mark;
Extension Line options.

You can insert the viewport on the layout as an object of predefined size or you can draw the
viewport as a rectangle by its diagonal, depending on the selected size option. The center of a new
viewport corresponds to the center of the selected source drawing: if you wish to display a specific
area of the drawing, select the viewport, click inside and move the source drawing within the
viewport till the desired area matches the center of the rectangle.
A viewport can be moved within the layout as a drawing object with its properties: frame and
background can have their color and line style.

Viewports created as rectangles can be resized by their selection handles, either vertices or
midpoints, or through the Object Info fields of Viewport Geometry. Viewports created by the extents
of the source drawing cannot be resized.

The information displayed in the
of the viewport can be quickly set and edited through
the ID section of the Object Info panel which provides the Id and Name fields and the button to
open the Viewport settings dialog.
For a quick access to the source sheet of the selected viewport, click the link icon on the upper left
corner of the viewport.

With this function available on the File menu it is possible to create single page or multiple pages
vector PDF documents which can be edited with other applications and printed with large format
printers and plotters.

Document pages: “Single Page” creates a one-page PDF document; “Multiple Pages” creates
as many pages as the visible sheets.
Include copyright info: this option adds information about the project from the Info pane of the
Project Settings window.
Publish menu brings the following options:
Current View to export the project as it is currently visible on screen;
Custom to select the desired sheets to export;
All Layouts to create a multiple page PDF document with all the layouts of the project;
List of the available Project Views to export the selected one.
List of all Sheets, Details and Layouts of the current project: select the sheets to include in the
PDF document for custom publishing.
Page Size menu. Available options are:
Fit Drawing Extents: page sizes are calculated on the extents of the drawings.
Available Sheet Size: this sub-menu lists the sheet sizes of project if already set; all sheets
get the size from the selected one.
ISO, ANSI, US ARCH standard sizes sub-menu.
Orientation of the selected page.
Option to scale the drawing to fit the selected page.

Option to apply graphic filters to the PDF.

Selecting objects for editing.
Undo, redo, cut, copy, paste and delete.
Modifying the position and placement of objects.
Translate, rotate, mirror, scale.
Extend, trim, intersect, break, split.
Fillet and chamfer, offset, extrude, explode, convert to polyline.

The Edit menu includes commands to quickly select items with some conditions. Apart from the
“Select All Sheets” command, all selection functions apply to the current sheet. The selection
commands follow the state of layers, and items on hidden or locked layers are not selected.
Select All Sheets selects all elements on all drafting sheets (SE & Pro);
Select All command selects all the elements on the current sheet;
Select Current Layer to select all the objects with the current layer;
Select All <object class>… selects all the elements on the current sheet of the same
class as the currently selected drawing tool;

Invert Selection selects all the elements and deselects those that were already selected;
Deselect deselects all the currently selected items.
Restore Last Selection: restores the last used selection even after having been
deactivated.
Drawing items can be selected either via the Arrow tool or by pressing the Shift key and clicking the
item or clicking with the right button of the mouse. See also the section “Selection” section on the
chapter Drafting Tools.

To search items within a project select Edit Find… to open the “Find” window.
The Find dialog lets you search items within the current sheet setting criteria to reduce the scope of
the function.
The upper section of the Search window shows the buttons corresponding to the graphic objects
you want to find within the currently selected sheet. These objects are arranged in three groups:
Drafting objects, Documentation objects and Architectural elements.
The optional search criteria offer the menus and fields needed to filter the search.

Object Class: push the button corresponding to the object class you want to find;
Sheet: select the sheet, drafting sheet, detail or layout (SE& Pro);
Style/Type: search items with a style or type (Pro);
Layer: search items within the selected layer;
Pen Color: stroke color of the objects to find;
Line-type: line type of the items to find;
Pen Weight: pen weight of the items to find;
Text: search for all occurrences of the text in the drawing;
Tag: enter the known tag to search elements with that tag (Pro);
Name: enter the name of architectural elements (Pro);
Description: enter the description to search matching architectural items (Pro).
The option “Zoom to selection” focuses the view on the objects that match the criteria.

The command Find All selects all the objects that match the criteria.
The command Find selects the objects one by one.

The Edit menu is commonly used for standard commands like undo and redo an operation; cut,
copy, paste and clear; select; search function; arrange and align items. It also provides the option
to open the Tool Settings window.

Most operations in HighDesign can be undone (and redone) up to 300 steps back, thus giving you
the maximum freedom in experimenting.
“Undo” and “Redo” apply to the following actions:
Creation of new items (e.g. new Line, new bézier, etc.)
Deletion of one or more selected items
Modification of selected items (e.g. extend, modify, trim, drag, etc.)
Complex operations (e.g. fillet, chamfer, paste, etc.)
In particular situations, it may be useful to suspend the action logging system used by the
Undo/Redo commands to save RAM. The Suspend Undo allows to temporarily put the Undo
engine to pause.

These are standard functions you find in all programs and provide some simple yet useful actions:
Cut means that selected items will be deleted from the drawing and put in memory for later
use;
Copy means copying the selected items to memory, without removing them from the project;
Paste lets you insert items stored in memory;
Delete is used to erase selected items from a project.
Objects copied from HighDesign are not stored in the system’s clipboard, but rather use an internal
copy and paste method, so that the system clipboard is available for images and texts.
The Paste command opens a dialog with options that allow to choose the source from which to
paste the objects, whether the system clipboard or the HighDesign clipboard. Other options include
the location of the pasted object and the destination layer.

The Copy As Image menu items let you copy the selected objects as image into the system
clipboard, for use in other graphics software. The objects are copied as images in one of the
following formats and resolutions:
PNG at 72 DPI
PNG at 300 DPI
PNG at 300 DPI with alpha channel
JPEG at 72 DPI
GIF
The objects are copied at the current zoom factor, and the higher the resolution, the more memory
is required to create the image. Since projects in HighDesign are made of vector elements that can
be zoomed in almost indefinitely, it is possible to run into low-memory situations when copying a
large project as image. Reduce the zoom or copy one area at the time to work around possible
hardware limitations.

Objects can be arranged on the drawing area both by their Z-axis, to control their
,
on the plane so that they are spaced evenly and
by their selection bounds.

Drawing objects are displayed on screen (and on printout) by their creation order: the first item
created is behind all others and the last object is on top of the others. If you place an opaque fill
over other items, it will cover everything behind it.
It is possible to change this order by sending back or to the front the selected items by using the
options in the Arrange sub menu of the Edit Menu:
Bring to Front sends the selected item to the front of all other items; if the selection contains
two or more items, they are moved with their internal order;
Bring Forward moves the selected items up one position;
Send Backward moves the selected items down one position;
Send to Back moves the selected items to the back of all other items.

The Arrange panel displays the buttons for all the Arrange Order, Align and Distribute objects
commands. Those commands modify the position of the selected objects according to specific
rules shown as menu options.

This command moves the selected objects sorting them by their position and the chosen rule.
Alignments by a direction use the first object in that direction among the selected objects as
alignment margin. For example, Align to Left Margin uses the left-most point of all selected objects
as left alignment margin.
The alignment rules are:
Left margin;
Center in column: aligns the objects vertically;
Top margin;
Center in row: aligns the objects horizontally;
Bottom margin.

Every object has a bounding box that defines the maximum extents of its dimensions. The
Distribute command allows you to position the selected objects according to the space between the
bounding rectangles. The first and last objects in the selected direction define the margins.
The options are:
Left Margin
Center in Row
Right Margin
Horizontal Spacing:
Top Margin
Center in Column
Bottom Margin
Vertical Spacing

Affine transformations are geometric transformations that modify the objects so that their lines and
internal parallelisms are preserved. These transformations are functions that alter the position,
scale and rotation of the objects in a way that the result object is affine to the original object.

Use this function to move (translate) selected items. Choose Drawing Move, then click to set a
start point, move the pointer and click again to set direction and offset of the translation.
selected objects

1. define the start point, origin of the translation;
2. define the end point.

Length (L + value; value)
Angle (A + value)
By holding down the Alt key, the Move tool turns to Duplicate. The Move command can be
activated in other ways too:
With the Selection tool, or during the editing of an object, by clicking the center point if
available;
With the Arrow keys, or Shift + Arrow key if set in Preferences

Workspace, to move the

selected objects by one linear unit; holding down the Alt key the offset is multiplied by 10.
Holding down the Cmd key, you can click on an object and begin a Move command with one
operation.

This function creates a copy of the selected items with a defined offset.
The Duplicate function can also be activated by the Arrow tool by pressing the Option key while
moving selected items.
Hold down the Command key to make multiple copies of the same selection in one session.
selected objects

1. define the start point, origin of the translation;
2. define the end point.

Length (L + value; value)
Angle (A + value)

This function creates a number of copies of the selected items. The method can be Increment,
where the distance between start and end point define the distance between each copy, or
Distribute, where the distance defines the maximum width of the copies. With this option, the
distance between the copies is calculated on the number of copies.
selected objects

1. Set number of copies and method, Increment or Distribute;
2. define the start point, origin of the translation;
3. define the end point.

Length (L + value; value);
Angle (A + value)
The Multiply/Distribute dialog can be used entirely with the keyboard: the Up and Down arrow keys
control the number of copies; Command + Up/Down arrow controls the option buttons.

Use this tool to create multiple copies of selected objects along a circular arc. The menu item
Drawing Polar Multiply opens the input dialog used to enter the number of copies and select
between increment and distribute.
selected objects

1. Set number of copies and method, Increment or Distribute;
2. define the center of the rotation;
3. define the start point of the arc
4. define the end point of the arc.
Angle (A + value)
The Polar Multiply/Distribute dialog can be used via the keyboard: the Up and Down arrow keys
control the number of copies; Command + Up/Down arrow controls the option buttons.

This function lets you rotate selected items around a central point and by an angle you define
graphically.

selected objects

1. define the first point, center point of the rotation;
2. define the start point;
3. define the end point and angle.
Angle (A + value)
You can also enter a rotation angle value by pressing the “A” key on the keyboard between steps 2
and 3.

Use this tool to rotate the selected objects in real time. The center of the rotation can be absolute,
which is the midpoint of the bounding box of the selection, or the center of the object, which rotates
each object around its own center.
selected objects

1. In the Rotate By Angle window, set the angle by using the slider or entering the value into the
input field;
2. Choose between global center of the selection and individual object center.

This command transforms objects by mirroring the selection around an arbitrary axis:
selected objects

1. define the start point, origin of the axis;
2. define the end point, angle of the axis.
Angle (A + value)

Just as Mirror, this function creates a mirrored copy of the selected items. The procedure is the
same as the “Mirror” command described above.
selected objects

1. define the start point, origin of the axis;
2. define the end point, angle of the axis.
Angle (A + value)

Use this command to pull and resize the objects within the selection rectangle: items which are
entirely within the selection rectangle will be moved whereas all other objects will be resized. Arcs,
circles, ellipses, text blocks, doors/windows and symbols will be rigidly dragged with no change of
shape.
selected objects

1. define the start point, origin of the translation;
2. define the end point.

Length (L + value; value)
Angle (A + value)

Use the Resize Drawing tool to change the size of the drawing by a per cent value or by numeric
values of width and height. The dimension can be made independent or proportional by clicking the
lock icon. The values can be entered in percentage or in any of the supported linear units.
By activating the Resize entire drawing by selection checkbox, the entire drawing will be
resized by the same amount applied to the selection. This is particularly useful when the
drawing is not at scale (usually an imported drawing or an inserted image file) and you need
to scale it. In this case, you can select an item of known size, open the Resize Drawing
window, activate the checkbox and enter the real values. The entire drawing will be resized
accordingly.

entire drawing / selected objects
enter one or both values of size
proportional values

This function finds all intersection points between two selected items. Supported intersections are:
selected objects
direct command

This command extends two selected lines or walls to their intersection: if the lines did not intersect,
they are extended; if they intersected each other, the functions shortens them to the point of
intersection.
This command cannot be applied to parallel items.
selected objects
direct command

This function extends the selected lines (either by lengthening or shortening) to their intersection
point with another object. Supported types are:
Construction line, Line, Polygon, Rectangle, Freehand line, Bézier curve, Arc / circle, Wall.
selected lines or walls
click on the destination object

This function splits into segments lines intersecting other lines, poly-lines, rectangles, hatches,
arcs, circles, freehands and bezier curves:
selected lines

click on the destination object

The Trim function is a multipurpose function designed to delete linear or curved segments or parts.
It applies to single segments without intersections with other objects as well as to segments
intersected by other objects.

Activate the tool and click on the segment to delete: if the trimmed segment belonged to a
rectangle or polygon, the remaining segments are turned into poly-lines.

Activate Trim and click on the segment or part of segment to delete: use this tool to clear a drawing
and cut segments, arcs and curves between intersections or extending off an edge with just a click.
To apply it:
1. Choose

or click on the corresponding icon of the Edit Tool Bar;

2. A visual aid highlights the segments under the pointer (1);
3. Click the parts of the objects you want to trim;
4. All segments and portions of arcs between intersections or extending off the edge will be
deleted (2);
5. Click an empty region to quit this command or press the Esc key.
You can also activate the Trim command by holding down the Backspace or Canc keys on the
keyboard and clicking the object, or by clicking with the eraser tip of a graphic pen. No selection is
required to use this function.
When activated with a selection, the selected objects acts as “cutters” and control the intersections.
All intersections that do not belong to a selected object are ignored.
objects at click
click on the destination object

This command is used to divide the selected line into the number of equal segments you specify in
the Divide Into dialog. This dialog lets you also choose whether divide the line with datum points or
actually create segments.
The Divide Into dialog can be used via the keyboard: the Up and Down arrow keys control the
number of divisions; Command + Up/Down arrow controls the option buttons.
selected objects
set the number of parts

This tool allows you to define a segment that will be subtracted from a selected line. Select
, click on a line to set the first point of the segment and click again to set the
endpoint.
selected objects

1. define the first point;
2. define the second point.

These commands allow to join two segments (lines, poly-lines or sides of a rectangle and regular
polygon) by an arc with a given radius, or by a chord with a given length. There are two ways to
use these tools:
Numeric:
1. Select two non parallel segments;
2. Choose

or

or click on the corresponding icon of the tool bar;

3. A text field shows up near the tool icon: insert the value of the radius or the length of the
chord and push Enter.
Graphic:
1. Select two segments;
2. Choose

or

or click on the corresponding icon of the tool bar;

3. Click on the white handle of the radius/chord and move the pointer along the constrained
direction perpendicular to the radius/chord to resize its length;
4. Click again to confirm.

When applied to poly-lines, you can change the vertex to modify by placing the cursor over the
vertex and wait for a second until the preview updates.
When applied to a rectangle or regular polygon, this function turns it into a poly-line.

This tool is used to create concentric duplicates of linear objects (lines, polygons, rectangles, polylines, freehands, arcs, circles and ellipses) at a given distance.
To activate the command, select the objects and go to
: enter the distance in the text
field showing up near the tool icon, then click on the white handle and move the pointer to choose
the side you want to place the duplicate on.
Click on the other objects if you want to apply the command with the current settings to other items.
Press ESC to conclude the command.

This graphic function simulates the extrusion along a direction of selected objects by creating
generatrices from the vertices and a duplicate of the selection.

Most of the drawing objects, such as polygons, poly-lines, freehand lines, Bézier curves, arcs and
circles, ellipses, hatched polygons, symbols, walls, windows and columns, can be converted to
simpler items by the Explode command.
Select the items you want to simplify and choose
: all the selected items are
converted to lines and the source object is deleted. Symbols are converted to their base items.

Use this command to convert the selected and connected objects (lines and arcs, regular polygons
and rectangles) into poly-lines.

This command applies a hatch or fill to the region described by the selected items. Supported
boundary items are:
Lines connected by their vertices (“segmented lines”);
Poly-lines;
Polygons;
Freehand lines;
Bézier curves;
Splines;
Arcs;
Circles;
Ellipses
To use this tool, select the boundary items, then choose
created with the current settings of the “Hatches and Fills” tool.

: a new fill/ hatch is

This function calculates the area of a region enclosed by the selected items. Supported boundaries
are:
Lines connected by their vertices (“segmented lines”);
Poly-lines;
Polygons;
Freehand lines;
Bézier curves;
Splines;
Circles, arcs, ellipses.
To use this command, select the boundary items, then choose Tools Calculate Area: a new text
label displaying the area of the region in the current units is created in the center of the selection.

The function “Find Center of Mass” calculates the position of the center of mass of the selected
polygons, closed poly-lines or hatches. To calculate the center of mass of curved regions like
circles or béziers, you can explode them and then apply this command to the selected lines.

This tool finds four points that define the lines tangent to two circles. To use this command, select
two circles or circular arcs, then choose
.

When you change font or style to the paragraph or even when you import texts from other
applications, the text box can be larger or smaller than its actual content: this command adjusts the
size of the selected text boxes.

Use this tool to reduce the complexity of the selected spline curves by adjusting the angle of the
segments defined by the vertices and by selecting a smoothing factor which ranges from Low,
through Medium, to High. A real time preview will show the resulting curve. Access this function via

Add resources to the project and organize the libraries.
Manage the project layers.
Add and manage dashed and special line types.
Linear hatches with multiple rules, vector patterns and bitmap textures.
Manage the color palettes.
(Pro)
Organize and create graphic styles and building element types.

A project resource is a loadable item that can be used in the project as is or in a modified version.
Layer sets, line types, hatches, styles are all project resources. HighDesign includes standard
libraries of resources and, in the SE and Pro editions, offers the ability to create new resources and
store them in custom libraries.
The Resource Manager window allows you to load line types, hatches, styles and other resources
into your project. In HighDesign SE and Pro, the Resource Manager also allows you to organize
your libraries of re-usable resources and create new items. Select
to
open it.

A resource item is similar to a template: when you load a resource into the current project,
HighDesign makes a copy of that resource that can be modified locally in that specific project
without affecting the other resources loaded in other projects.
Editing the original resource file is also possible for custom resources, and a project can be
updated to use a new version of a resource by reloading it. Default items that are located in the
HighDesign library cannot be edited, but they can be duplicated and edited as custom items.
In HighDesign, resources like line-types, hatch types, and symbols can be stored in three
libraries: the
, which is internal and cannot be edited; the
, which
extends the internal library with all the custom resources created by you; the
,
which includes the items loaded in the project and can include any imported resources that are
available in the current project only.
does not support custom libraries: new resources are automatically created inside
the current project.

Use the Layers pane to create, delete and organize the layers of your project.

The options available in the Layers pane are:
Default tool
Layer opacity

Layer name

Number of objects on each layer

Visibility

Lock

Color

The buttons on the lower side of the window serve the following functions:
new layer
delete layer
action menu with selection options
Import and export layer set
Bind Layers to drawing tools.
Almost all operations on layers can be performed via the main layers table, where each row
displays all the layer attributes.
The second and the third columns display the layer name and the number of items on each
layer: double click to change the name. The last four columns display the layer attributes:
visible / invisible, locked / unlocked, default color and opacity.

To reorder a row, just drag it to the new position: note that reordering has no visual effect on
the display order of layers, but it allows you to keep them organized in a way that’s most
convenient to you. To create or delete a layer use the buttons below the table; you can delete
any layer anytime, but at least one layer must always be present.
Both new layers and those imported from other documents are automatically set as document
layers only, meaning that they only exist within the owner project.

Layers can be associated to certain drawing tools with the “Bind layers to drawing tools” checkbox.
When this option is active, each drawing tool is linked to a layer: when you select a tool, its layer
automatically becomes active, thus simplifying the process of organizing a project.
For instance, in an architectural project freehand lines might only be used to design the landscape:
linking the “Freehand” tool to a “Terrain” layer is a convenient way of keeping the project organized
without having to change layer each time you change tool.
The first column of the Layers table shows the drawing tool connected with the layer if the Bind
Layers to Drawing Tools option is selected. Click to choose the tool or method to bind.

This pane lists the line types of the project. By default a new project comes with only few line types
available, continuous and various dashed lines. Use the Line-types Manager to add more lines to
the project, create new types, edit custom lines, and organize the resources.

The options in this pane include:
Loading a saved line-type into the project or removing a type from the project
Creating a new line type
Duplicating and editing line types
Deleting a line type from the project
Reordering the project line-types
The main table lists all the line types that are currently loaded in the project. A loaded item is
available for use in the project and does not necessarily mean that it is actually used by some
object.

Select an item in the Project library to see its preview and inspect its values. Depending on the
selected item’s location, it can be edited or deleted if it is a custom item, or duplicated.
You can search for a specific line type by entering its name in the search field.
The list order of project line types can be rearranged by dragging a line type to its new position.

Press the Load button or click the + button to the left of the Project list to reveal the libraries. Select
the item to load and push the plus button or drag the item to the Project list. The item is loaded into
the project and immediately available for use.

You can duplicate any line type. To duplicate, select a line type and either push the Duplicate button
on the bottom side of the window or the pop-up duplicate button on the selected selected line type’s
cell when available.
The duplicated line type is automatically opened for editing so you can modify its name and values
directly.

1. Click the “New line” button.
2. Select a base type from the Line type pop-up menu.
There are two main families of line types:

Dashed lines are defined by a repeated pattern of dashes and gaps. The values of the pattern can
be defined in any of the base linear units: millimeters, inches and pixels/points.
A dash pattern can have up to six dash-gap pairs. A value of 0.0 means that the item will be
rendered as a dot.

Special lines can be made of different shapes and patterns and are defined by frequency and
intensity values. Frequency controls the extent or the distance between the repetitions; intensity
controls the size of the item.
Special lines can be created from pre-defined types like insulation, zigzag, vertical dash, etc.
When the line type is defined, push the Save button to save it. The line type will be saved as a
loadable resource file if the chosen location is the user library, or as an internal resource if saved in
the current project.

Custom and project line types can be edited by pushing the Edit button on the selected item’s cell.
It is possible to change any of the parameter values and the name, but not its location.

Only custom and project line types can be deleted. Select the line type and push the Delete button.
Objects that use that type will be reverted to Continuous line.

This pane lists the hatch patterns of the project and it is used to create, edit and organize vector
hatch patterns. The functions provided by this pane work mostly in the same way as those on the
Line Types pane.
HighDesign provides three families of hatch fills:

, made of parallel lines, continuous or with a specific dash pattern, with
variable offsets and angle. A set of line type, angle, and offsets is a skin. A linear hatch can
have up to eight overlaid skins.
. A pattern is a vector drawing that is tiled (repeated) along rows and columns.
Each tile contains the drawing that is clipped inside the hatched region.
: an image tiled inside the hatched region.

Select an item in the Project library to see its preview and inspect its values. Depending on the
selected item’s location, it can be edited or deleted if it is a custom item, or duplicated.
Use the icon buttons above the Project list to filter the listed items by family.
The list order of project hatch types can be rearranged by dragging a hatch type to its new position.

Press the Load button or click the + button to the left of the Project list to reveal the libraries. Select
the item to load and push the plus button or drag the item to the Project list. The item is loaded into
the project and immediately available for use.

You can duplicate any hatch type. To duplicate, select a hatch type and either push the Duplicate
button on the bottom side of the window or the pop-up duplicate button on the selected selected
hatch type’s cell when available.
The duplicated hatch type is automatically opened for editing so you can modify its name and
content directly.

Press the New Hatch Type button and choose the desired family from the pop-up menu.

Depending on the family, the interface changes and shows the relevant fields and tools.

A linear hatch is defined by a line repeated multiple times according to several parameters like
spacing, angle, offset, etc. A set of parameters is called a “skin”. A linear hatch in HighDesign can
have up 8 skin definitions that are rendered in sequence.

A skin has the following parameters:
Angle: in degrees, defines the orientation on the plane of the vector.
Spacing: the distance between two lines, in the current units.
Origin Dx, Dy: these values control the offset of the current skin from the origin of the hatch.
All the spacings are calculated from the origin point of the hatch, which allows you to align the
pattern to your design. By entering an X and Y offset the entire skin is moved off from the
origin by those values. This is particularly relevant when the hatch is made of multiple skins.
Line-type: can be continuous, custom dashed or one of the project line types.
Custom dashed line types can have up to three dash-gap pairs. The values are
expressed in the current unit.
Custom dashed lines can have an alternate offset: the origin of every second line will be
moved by the alternate offset value. For example, this is useful to create masonry
patterns where the vertical lines are dashed lines with an alternate offset.

The second section allows you to enter a name for the new resource and select its location.
Name: enter a name for the new resource. If the chosen name conflicts with another resource
in the same location, you will be asked to review the name entered.
Location: select the destination library of the new resource.

When you select New Tiled Pattern from the new hatch menu, the workspace switches from
“Project” to “Edit Pattern”. This workspace allows you to design the typic tile of the hatch pattern
using a sub-set of the drafting tools and to define its size. The Edit Pattern panel provides a
preview of what the tile will look like when rendered as a pattern and allows you to define the tile’s
width and height.
In this workspace the drawing scale is set as 1:1. The available drawing tools are Selection Arrow,
Construction Objects, Lines, Segmented Lines, Rectangles and Regular Polygons. The drawing
area is set by the size of the tile.

You can also Copy/Paste drawings from the main window of HighDesign: in this case it is advisable
to set the size of the tile before pasting the pattern since tile, drawing area and pattern must have
the same size.
In the drawing area you can draw and edit the pattern exactly as in the main window. When the
pointer is close to the middle of the tile, the median axes become visible to provide a visual aid to
mirror or rotate objects. Other alignment points are available on the borders of the tile to make it
easier to design the tile and avoid gaps.
The preview window provides the fields to set the size of the tile and the zoom slider: once the
drawing is complete, just push the “OK” button in the preview window and the focus turns back to
the Hatch Manager.

Another family of hatch is the texture, which tiles and repeats an image inside the boundary area.
To create a new texture, click the Add (+) button, select New Texture and choose the image in any
of the supported file types.
A texture only supports 90° rotations, and can be scaled via the Hatch Properties panel. The origin
of the texture can changed just as in linear hatches and patterns, by moving the center point when
the hatch object is selected in the drawing.

Custom and project hatch types can be edited by pushing the Edit button on the selected item’s
cell. It is possible to change any of the parameter values and the name, but not its location.

Select a custom type; note that only custom hatch types can be deleted;
Push the “Delete” button.

Drawing items in HighDesign by default have an indexed color from a Standard palette of 256
colors. The Colors pane on the left lists the default palette and provides the options to activate or
create new palettes and add them as resources to the project.

Click the Switch buttons to add other default palettes (Grays, AutoCAD® ACI, ISO/DIN) to the
project. The buttons on the bottom of the palette list are:
, to create a new custom palette; use the “+” and “-” buttons to add or remove
colors to set through the color picker. Click the green check mark to confirm; new palettes are
automatically saved in the User Library.
the selected palette.
the selected custom palette.
external palettes through the .xml and .ase file formats.
a palette as a resource available for external use. Use the controls and the info
displayed on the right side of the panel to check the values of the chosen colors or to set the
new colors of the custom palette through the color slider and picker. Analytically set the color
values via the HEX or RGB fields. The opacity slider and field control the Opacity value of the
color. Use the Name field to set the color name.

Use the controls and the info displayed on the right side of the panel to check the values of the
chosen colors or to set the new colors of the custom palette through the color slider and picker.
Analytically set the color values via the HEX or RGB fields. The opacity slider and field control the
Opacity value of the color. Use the Name field to set the color name.

Bind a color to a pen weight, so that choosing a pen color in the project automatically sets the
associated pen weight.
Activate the “Bind colors to pen weight” option, click a color and choose a pen weight from the
pop-up menu; the selected pen number appears on the color box. To remove a pen from a
color, press the Option key on the keyboard and click the color box or choose “None” from the
pop-up menu.
The color-pen binding works in one direction only: selecting a color also selects its pen
weight, but selecting a pen weight does not change the current color. This allows you to
change the pen weight of an object at any time without affecting its pen color. Color-pen
bindings are saved in the current document.

The Styles & Types manager pane lets you add pre-defined styles and types to your project, create
new items and manage the libraries. The underlying method of operation is the same as the other
resource panels, the main difference being that styles and types are organized by class in subfolders. For more information on styles and building types, see the chapter Styles and Types.

Select a folder to view its items on the preview table, or select All to view all the styles and types
loaded in the current project. You can also search a particular style by entering its name in the
search field.

Press the Load button or click the + button to the left of the Project list to reveal the libraries. Select
the item to load on the preview table and push the pop-up Add button on the item’s cell. The item is
loaded into the project and immediately available for use.

You can duplicate any style or type. To duplicate, select the item on the preview table and press the
Duplicate button, visible below the table. The item is duplicated and opened for further editing.

Press the New Style/Type button to create a new item. The right half of the window shows the
panes where you can define the style. The number of tabs is variable and depends on the family of
the style, but all styles have at least the Style Settings tab where you can define the common
attributes such as class, name, tag, description and the graphic options that the style controls.

Custom and project styles and types can be edited by pushing the Edit button on the selected
item’s cell. It is possible to change any of the parameter values and the name, but not its location.

Select a custom type; note that only items in the project and user libraries can be deleted;
Push the “Delete” button.

Store named views of the project.
Straighten pictures and create their vector projection.
Edit brightness, contrast, colors, etc.
Create high-impact images of your drawings.

A project view is a snapshot of the project that stores a specific status of view position and zoom,
sheet visibility and layers. Views are named and listed on the Project Views panel with their
thumbnail.
Project views can also be used as an alternative way to create presentations ready for printing: in
addition to sheets and layouts, the Print windows lets you select a specific project view.
A project view stores the visibility status of current sheets and layers and allows you to create
for instance a “layout” of a plan with dimensions and surfaces and another “layout” of the
same plan (sheet) with services only.
Thanks to the transparency option of drafting sheets and by combining visible sheets and
layers you can create complex project views for your printouts: in the Print window you can
select the Project View you wish to print through the Views menu.
Project views store the following data:

Position and zoom factor of the current view
Visible layers and layer opacity
Visible worksheets

The Views panel provides a list of all saved project views. A pop-up preview of the views shows up
when the pointer is over a view’s name. Click on a view’s name to activate it or double-click to
rename.

To add a view, click the Save current view button and type a name: saved views include
position, magnification factor, and visible sheets and layers.
To delete the currently selected view, click the Delete View button.
The Update View button redefines the selected view by the current settings.

HighDesign Pro provides a powerful, single-image photogrammetry tool to obtain the actual
projection of the architectonic elements captured in a picture: this function can be used for surveys
of architectural façades and any planar surface and it only needs a normal camera and two
measures. No specific equipment nor knowledge is required.
Photogrammetry in HighDesign offers two tool methods:
: transforms the original image by rectifying the perspective deformation
: creates a corrected projection by tracing the elements in the image
after the internal geometry of the image has been set up. All projections are vector-based.
The following are some requirements and suggestions to obtain the best results:
The image must include at least two horizontal and two vertical items (e.g. a door, a window,
wall bricks) and, if available but not strictly required, two items with the third dimension. These

requirements are the only really needed to use the photogrammetry tool in HighDesign.
If possible, avoid too angled views because the projection could be deformed on the edges of
the image;
For the same reason as above, avoid fisheye lenses (<28 mm);
The image should include at least one horizontal and one vertical dimension; however, if you
do not have those dimension, you can set up the projection with any dimension and later
resize the resulting drawing.
As a rule of thumb, make sure the image includes some reference items and it has not been
clipped or deformed. When the third direction (depth) is not available, the internal geometry of the
view relies on the diagonals of the picture’s rectangle, hence the importance of preserving the
original shape of the picture.

The setup process is very simple and it does not require any specific knowledge.
To start a photogrammetry, select
. HighDesign switches to the
Photogrammetry workspace, with the Photogrammetry setup window, a gray background and a
limited set of drawing tools:
Arrow;
Construction objects;
Lines;
Poly-lines with straight segments;
Hatches;
Curves;
Viewing tools (Panning, Zoom and Measure).

Push the “Choose…” button and select the image file to open. Supported file types are: TIFF, PNG,
JPEG.

Press the “Next” button: the image is now displayed on screen and the Photogrammetry setup
window changes.

Once the image is open, select the geometric type of the object in the picture. There are two
possible options, based on the visible geometry and camera angle:
All three directions X, Y and Z are visible in the image: there are at least two horizontal lines,
two vertical and two for the depth;
Two directions X, Y are visible. The image shows at least two horizontal lines and two
vertical, but no depth line is visible; this type includes pictures taken with the lens parallel to
the surface and scans of plans.
When you choose the geometry type, a grid is added to the image on the drawing area. Adjust the
grid to match the shape of the object in the picture.
Click the handles of the grid on its vertices and move them until they match the horizontal and
vertical cue lines that are visible in the picture. Windows, side walls, sills, jambs of doors and
windows and frames are all useful elements.
If the geometry shows two sides of the object, a second grid serves for the reconstruction of the
third direction. Drag the two blue depth lines by their endpoints to match the depth cue lines on the
picture. You can adjust the grid and the depth lines keeping in mind that usually lines far from the
center of the picture have a deformation depending on the quality and focal length of the used lens.

The focal length value is optional.
Push “Next” button to go to the next step of setup.

Two lines, one green vertical and one red horizontal, are displayed over the picture. These lines,
drawn in the perspectival view corresponding with the internal geometry of the picture, will be
utilized to enter the two known measures.
Drag the vertical line over the known dimension, in this case the jamb of the arched door, and
stretch/shorten it by the endpoints till it matches the known object: enter the known vertical
measure in the corresponding field of the setup floating window and select the drawing units.
Drag the horizontal line over the known object, the sill of the door, adjust it till it matches the
known dimension and enter the actual measure in the corresponding field and set the drawing
scale of the projection.

The setup is now complete and it is possible to choose the mode of projection between image
deformation and vector projection. By choosing the image deformation the image will be stretched
to correct the perspective deformation and match the given proportions: the resulting image then
could have to be resized to fit the known measures.
The second option, “Trace and Project”, consists in tracing all the objects of the image you wish to
survey to get the projection at the desired drawing scale.

As already mentioned, the workspace of the Photogrammetry tool provides a limited set of drawing
tools and three Sheets are listed in the Sidebar: “Sheet 1”, the sheet created by default when you

launch HighDesign; “Photogrammetry”, which stores the image and all the setup data and this is
the sheet you use to trace all the objects to project; “Projection”, which is displayed as a floating
window when you are on sheet “Photogrammetry”. Also, this workspace has the following
characteristics:
Directions are constrained to vanishing points; holding down the Shift key while drawing or
tracing lines, the directions are constrained to the closer vanishing point, vertical or horizontal.
The Projection window displays the result of all projections, that is, all the items drawn within
the Photogrammetry environment are projected in real time at the drawing scale previously
set.
The “Projection” sheet, as all drafting sheets, can be used to draw, edit, save and export the
projection like a separate drawing.

The Tools menu includes some commands that are specific to the Photogrammetry workspace and
allow you to manage some important functions:
Photogrammetry: used to start a new photogrammetric projection or to resume the current
one.

Reset Photogrammetry: clears all settings (geometry and known dimensions) and brings the
photogrammetry process back to the setup step; the setup window opens again and all
projected items are removed. Please pay attention when using this command as it’s not
undoable.
Exit Photogrammetry: hides the picture from the project and pauses the Photogrammetry
environment switching the workspace to Project. Items drawn to the current sheet are not
deleted; select “Photogrammetry” to resume the photogrammetry.

HighDesign lets you insert images into a project and treat them as any other vector object. The Edit
Image tool (Tools menu) lets you edit and crop the image, enhance and adjust the values of
brightness, contrast and saturation.
It often happens to have the need to adjust the brightness, contrast, levels of color of an image to
be used for a photogrammetric projection or as a background for a drawing: HighDesign provides
an integrated image editing module to quickly apply many image enhancements.
To edit an image, select it and choose Tools
edit the selected image.

Adjust Image: a window opens with all the controls to

The Adjust Image dialog shows the preview of the image on the top. The controls are grouped as
transformation buttons, advanced filters buttons and the sliders for brightness, contrast and
saturation. The available options are:
Transform:
Mirror Horizontal, mirrors the image horizontally on its Y axis;
Mirror Vertical, mirrors the image vertically on its X axis;
Crop, trims the borders of the image leaving the selected area only;
Focus and Colors:
Grayscale, changes all colors to gray;
Invert, inverts all colors from positive to negative and vice versa;

Sharpen, enhances the contrast on the edges;
Blur, smoothes the image;
Brightness, controls the amount of light in the image;
Contrast, adjusts the contrast between colors;
Saturation, enhances the color saturation.
To apply a filter, push the corresponding button or move the slider. Sharpen and blur filters can be
applied multiple times. Any filter you apply, which you can preview in the thumbnail, is stored in a
temporary image until you push the “Apply” button, which applies all filters in queue to the main
image, while the “Cancel” button clears the filter queue.
The “Revert Image” button, on the lower left hand corner of the window, clears all applied filters
from the image.

This is a 2D rendering tool that creates high-quality images of your project with varying effects of
background, pen and fill colors, border and margins, watermark and adjustable size and resolution.
This tool not only applies anti-aliasing to object edges, but it also allows customizable print size and
image resolution and provides background options, frames and color effects to make high impact
presentations of your projects. The result is an image that can be exported into any of the
supported graphic file formats. To set all options, select
to open the image settings
dialog.

Use this dialog to set the visual effects and options to create an illustration.
1. Image effects: click to show the graphic options.
2. Border: option to display a border, color and thickness of the margin.
3. Watermark: options to add a digital signature or watermark to the image.
4. Image size: options to set the image resolution and size.
5. Preview of the resulting image.
6. Buttons to save the current settings as a new theme or to delete the selected theme.
7. List of loaded themes.
Once all the settings are done, if you wish to save the current settings as a new theme for future
use, just push the “+” button close to the themes menu to see it listed on the menu with the desired
name. Click “Ok” to confirm and open a new window displaying the resulting image or “Cancel” to
dismiss this dialog.

The options to apply graphic effects to the image include:
Background:
By Project: sets the background to the same color as used in the main project window;
Plain Color: use the button to select the color;
Horizontal Gradient: select left and right colors of the gradient;
Vertical Gradient: select upper and lower colors of the gradient;
Image, tiled: draws an image as background; pictures smaller than the destination
image are tiled; select the image from disk;
Image, resized: draws an image as background scaling it to fit the destination image.
Images are scaled non-proportionally; select the image from disk.
Drawing Color:
By project: keeps the original colors of the drawing;
Custom color: choose the color on the pop-up menu.
Fill Color:
None;
By Project;
Monochromatic: choose the color on the pop-up menu;
Grayscale;

Sepia.
Line type: select the line type from the loaded list.

The Watermark feature of the “Render” tool allows you to add a text watermark to the image: the
text style options include Font, size, text style (bold, italic, underline) and color. Through a menu it
is possible to set the position of the watermark within the image.

In this pane are grouped all the options to set the desired format, size and resolution of the
resulting image.
Preset: choose the size that best fits your needs from the many standard formats in the
menu;
Pixel Size: use the fields to enter your custom image size in pixels: click the icon to lock the
desired ratio;
Resolution: set a resolution of 72 dpi for Web publishing or presentations, whereas 300 dpi or
higher resolutions are best for print output;
Print Size: you can set width and height of the printout, using the menu on the right to set the
units.

The resulting image is displayed on a new window which provides some buttons, including the
zoom buttons: press the “Save” button to export the image as a TIFF, PNG or JPEG file or the
“Copy” button to copy the image to the clipboard.
You can also drag and drop the image on the main project window to insert it in the current sheet.

Clean up the document, internal references and fix incorrect values.
Remove all unused layers, line-types, hatches, and other resources.

Documents can occasionally contain damaged or invalid objects when they are imported from other
formats, or when crashes or power failures occur while saving a project.
This command checks the document for damaged items, such as unreferenced hatches,
incomplete vertices or zero-length segments, and deletes them. It also rebuilds the internal
identification handles of each object and checks the bounds of the windows.
To repair the document, choose

. This command cannot be undone.

A project, especially when opened from a different edition of HighDesign or when imported from a
different file format, can include unnecessary resources and items, like unused line-types, hatches,
symbols.
To remove unused items from the project, choose

.

In the dialog window, check the kind of items and resources that you want to purge and click OK.
Default resources that are loaded automatically with each new project will not be deleted, even if
unused in the current project.

This command cannot be undone.

